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INTRODUCTION

It has been said that Sir Isaac Newton was the last person to know everything. He was an
accomplished physicist (his three laws of motion were the basis of classical mechanics, which
defined astrophysics for three centuries), mathematician (he was one of the inventors of calculus and
developed Newton’s Method for finding roots of equations), astronomer, natural philosopher, and
alchemist (okay, maybe the last one was a mistake). He invented the reflecting telescope, a theory of
color, a law of cooling, and studied the speed of sound.

Just as important, he was born before relativity, quantum mechanics, gene sequencing,
thermodynamics, parallel computation, and a swarm of other extremely difficult branches
of science.

If you ever used Visual Basic 3, you too could have known everything. Visual Basic 3 was a
reasonably small but powerful language. Visual Basic 4 added classes to the language and made
Visual Basic much more complicated. Versions 4, 5, and 6 added more support for database
programming and other topics such as custom controls, but Visual Basic was still a fairly
understandable language, and if you took the time you could become an expert in just about

all of it.

Visual Basic .NET changed the language in much more fundamental ways and made it much harder
to understand every last detail of Visual Basic. The .NET Framework added powerful new tools to
Visual Basic, but those tools came at the cost of increased complexity. Associated technologies have
been added to the language at an ever-increasing rate, so today it is impossible for anyone to be an
expert on every topic that deals with Visual Basic.

To cover every nook and cranny in Visual Basic you would need an in-depth understanding of
database technologies, custom controls, custom property editors, XML, cryptography, serialization,
two- and three-dimensional graphics, multi-threading, reflection, the code document object model
(DOM), diagnostics, globalization, Web Services, inter-process communication, work flow, Office,
ASP, Windows Forms, WPF, and much more.

This book doesn’t even attempt to cover all of these topics. Instead, it provides a broad, solid
understanding of essential Visual Basic topics. It explains the powerful development environment
that makes Visual Basic such a productive language. It describes the Visual Basic language itself and
explains how to use it to perform a host of important development tasks.

It also explains the forms, controls, and other objects that Visual Basic provides for building
applications in a modern windowing environment.

This book may not cover every possible topic related to Visual Basic, but it does cover the majority
of the technologies that developers need to build sophisticated applications.
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SHOULD YOU USE VISUAL BASIC 2010?

xlii

Software engineers talk about five generations of languages (so far). A first-generation language
(1GL) is machine language: Os and 1s. For example, the binary command 00110010 00001110
00010010 00000000 might mean to combine the register CL with the value at address 12H by
using the exclusive-or (XOR) operation. Pretty incomprehensible, right? You actually had to
program some early computers by painstakingly toggling switches to enter Os and 1s!

A second-generation language (2GL) is an assembly language that provides terse mnemonics for
machine instructions. It provides few additional tools beyond an easier way to write machine code.
In assembly language, the previous XOR command might look like xor c1,, [12H]. It’s a lot better
than assembly language but it’s still pretty hard to read.

Third-generation languages (3GLs) are higher-level languages such as Pascal and FORTRAN. They
provide much more sophisticated language elements such as subroutines, loops, and data structures.
In Visual Basic, the previous example might look something like total = total Xor value.

WHERE DID THE REGISTER GO?

Higher-level languages generally don’t directly use registers or memory addresses.
Instead they work with variables such as total and value. The language’s
compiler figures out when a value should be placed in a register or other location.

Fourth-generation languages (4GLs) are “natural languages,” such as SQL. They let developers use
a language that is sort of similar to a human language to execute programming tasks. For example,
the SQL statement “SELECT * FROM Customers WHERE Balance > 507 tells the database to
return information about customers that owe more than $50.

Fifth-generation languages (SGLs) provide powerful, highly graphical development environments to
allow developers to use the underlying language in more sophisticated ways. The emphasis is more
on the development environment than the language itself.

The Visual Studio development environment is an extremely powerful fifth-generation tool. It pro-
vides graphical editors to make building forms and editing properties easy and intuitive; IntelliSense
to help developers remember what to type next; auto-completion so developers can use meaning-

ful variable names without needing to waste time typing them completely by hand; tools that show
call hierarchies indicating which routines call which others; and breakpoints, watches, and other
advanced debugging tools that make building applications easier.

Visual Studio is so powerful that the answer to the question of whether you should use it is practi-
cally obvious: if you want to write powerful applications that run in a Windows operating system,
you should use Visual Studio.

Visual Basic is not the only language that uses Visual Studio. The C# language does, too, so now the
question is, should you use Visual Basic or C#?



INTRODUCTION

LOTS OF LANGUAGES

Visual Studio also supports a few other languages including Visual C++, Visual J#,
and Visual F#, and in theory it could support others in the future. Visual Studio
originally built for Visual Basic and C# was designed to work with Visual Studio so
Visual Studio provides the most support for these.

A Visual Basic programmer’s joke asks, “What’s the difference between Visual Basic .NET and C#?
About three months!” The implication is that Visual Basic .NET syntax is easier to understand and

building applications with it is faster. Similarly, C# programmers have their jokes about Visual Basic
.NET, implying that C# is more powerful.

In fact, Visual Basic .NET is not a whole lot easier to use than C#, and C# is not significantly more
powerful. The basic form of the two languages is very similar. Aside from a few stylistic differences
(Visual Basic is line-oriented; C# uses lots of braces and semicolons), the languages are comparable.
Both use the Visual Studio development environment, both provide access to the .NET Framework of
support classes and tools, and both provide similar syntax for performing basic programming tasks.

The main difference between these languages is one of style. If you have experience with previous
versions of Visual Basic, you will probably find Visual Basic 2010 easier to get used to. If you have
experience with C++ or Java, you will probably find C# (or Visual C++ or Visual J#) easy to learn.

Visual Basic does have some ties with other Microsoft products that increase its value. For example,
Active Server Pages (ASP) and ASP.NET use Visual Basic to create interactive web pages. Microsoft
Office applications (Word, Excel, PowerPoint, and so forth) and many third-party tools use Visual
Basic for Applications (VBA) as a macro programming language. If you know Visual Basic, you
have a big head start in using these other languages. ASP and VBA are based on pre-.NET versions
of Visual Basic, so you won’t instantly know how to use them, but you’ll have an advantage if you
need to learn ASP or VBA.

If you are new to programming, either Visual Basic 2010 or C# is a good choice. I think Visual
Basic 2010 is a little easier to learn, but I may be slightly biased because I’ve been using Visual Basic
since long before C# was invented. You won’t be making a big mistake either way, and you can
easily switch later, if necessary.

WHO SHOULD READ THIS BOOK

This book is intended for programmers of all levels. It describes the Visual Basic 2010 language
from scratch, so you don’t need experience with previous versions of the language. The book also
covers many intermediate and advanced topics. It covers topics in enough depth that even experi-
enced developers will discover new tips, tricks, and language details. After you have mastered the
language, you may still find useful tidbits throughout the book, and the reference appendixes will
help you look up easily forgotten details.

xliii
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The chapters move quickly through the more introductory material. If you have never programmed
before and are intimidated by computers, you might want to read a more introductory book first. If
you are a beginner who’s not afraid of the computer, you should have few problems learning Visual
Basic 2010 from this book.

If you have programmed in any other language, fundamentals such as variable declarations, data
types, and arrays should be familiar to you, so you should have no problem with this book. The
index and reference appendixes should be particularly useful in helping you translate from the lan-
guages you already know into the corresponding Visual Basic syntax.

HOW THIS BOOK IS ORGANIZED

The chapters in this book are divided into five parts plus appendixes. The chapters in each part
are described here. If you are an experienced programmer, you can use these descriptions to decide
which chapters to skim and which to read in detail.

Part I: IDE

xliv

The chapters in this part of the book describe the Visual Studio integrated development
environment (IDE) from a Visual Basic developer’s point of view. The IDE is mostly the same for
C# and other developers, but a few differences exist, such as which keyboard shortcuts perform
which tasks.

Chapter 1, “Introduction to the IDE,” explains how to get started using the Visual Studio integrated
development environment. It tells how to configure the IDE for different kinds of development. It
defines and describes Visual Basic projects and solutions, and shows how to create, run, and save a
new project.

Chapter 2, “Menus, Toolbars, and Windows,” describes the most useful and important commands
available in the IDE’s menus and toolbars. The IDE’s menus and toolbars include hundreds of com-
mands, so this chapter covers only those that are the most useful.

Chapter 3, “Customization,” explains how to customize the IDE. It tells how you can create, hide,
and rearrange menus and toolbars to make it easy to use the tools that you find most useful.

Chapter 4, “Windows Forms Designer,” describes the designer you can use to build Windows
Forms. It explains how to create, size, move, and copy controls. It tells how to set control properties
and add code to respond to control events. It also explains how to use handy designer tools such as
smart tags and command verbs.

Chapter 5, “WPF Designer,” explains how to use the Windows Presentation Foundation (WPF)
form designer. This chapter is similar to Chapter 4 except that it covers WPF forms instead of
Windows Forms.
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Chapter 6, “Visual Basic Code Editor,” describes one of the most important windows used by
developers: the code editor. It explains how to write code, set breakpoints, use code snippets, and
get the most out of IntelliSense.

Chapter 7, “Debugging,” explains debugging tools provided by Visual Studio. It describes the
debugging windows and explains techniques such as setting complex breakpoints to locate bugs.

Part Il: Getting Started

The chapters in this part of the book explain the bulk of the Visual Basic language and the objects
that support it. They explain the forms, controls, and other objects that a program uses to build a
user interface, and they tell how you can put code behind those objects to implement the program’s
functionality.

Chapter 8, “Selecting Windows Forms Controls,” provides an overview of the Windows Forms
controls that you can put on a form. It groups the controls by category to help you find the controls
you can use for a particular purpose.

Chapter 9, “Using Windows Forms Controls,” gives more detail about how you can use Windows
Forms controls. It explains how you can create controls at design time or runtime, how to set
complex property values, and how to use useful properties that are common to many different kinds
of controls. It explains how to add event handlers to process control events and how to validate
user-entered data.

Chapter 10, “Windows Forms,” describes the forms you use in a Windows Forms application.
Technically, forms are just another kind of control, but their unique position in the application’s
architecture means they have some special properties, and this chapter describes them.

Chapter 11, “Selecting WPF Controls,” provides an overview of WPF controls. It groups the
controls by category to help you find the controls you can use for a particular purpose. This chapter
is similar to Chapter 8 except it covers WPF controls instead of Windows Forms controls.

Chapter 12, “Using WPF Controls,” gives more detail about how you can use WPF controls.
This chapter is similar to Chapter 9 except it deals with WPF controls instead of Windows Forms
controls.

Chapter 13, “WPF Windows,” describes the windows that WPF applications use in place of
Windows forms. This chapter is similar to Chapter 10 except it deals with WPF windows instead
of Windows forms.

Chapter 14, “Program and Module Structure,” describes the most important files that make up a
Visual Basic project. It describes some of the hidden files that projects contain and explains some
of the structure that you can give to code within a module, such as code regions and conditionally
compiled code.
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Chapter 15, “Data Types, Variables, and Constants,” explains the standard data types provided by
Visual Basic. It shows how to declare and initialize variables and constants, and explains variable
scope. It discusses technical topics, such as value and reference types, passing parameters by value
or reference, and creating parameter variables on the fly. It also explains how to create and initialize
arrays, enumerated types, and structures.

Chapter 16, “Operators,” describes the operators a program uses to perform calculations. These
include mathematical operators (+, *,\), string operators (&), and Boolean operators (And, Or).
The chapter explains operator precedence and potentially confusing type conversion issues that
arise when an expression combines more than one type of operator (for example, arithmetic and
Boolean).

Chapter 17, “Subroutines and Functions,” explains how you can use subroutines and functions
to break a program into manageable pieces. It describes routine overloading and scope. It also
describes lambda functions and relaxed delegates.

Chapter 18, “Program Control Statements,” describes the statements that a Visual Basic program
uses to control code execution. These include decision statements, such as If, Then, or Else and
looping statements, such as For and Next.

Chapter 19, “Error Handling,” explains error handling and debugging techniques. It describes the
Try Catch structured error handler, in addition to the older On Error statement inherited from early
versions of Visual Basic. It discusses typical actions a program might take when it catches an error.
It also describes important techniques for preventing errors and making errors more obvious when
they do occur.

Chapter 20, “Database Controls and Objects,” explains how to use the standard Visual

Basic database controls. These include database connection components that manage connections
to a database, DataSet components that hold data within an application, and data adapter controls
that move data between databases and DataSets.

Chapter 21, “LINQ,” describes language integrated query (LINQ) features. It explains how you
can write SQL-like queries to select data from or into objects, XML, or database objects. It also
explains PLINQ, a parallel version of LINQ that can provide improved performance on multi-core
systems.

Chapter 22, “Custom Controls,” explains how to build your own customized controls that you can
then use in other applications. It covers the three main methods for creating a custom control:
derivation, composition, and building from scratch. This chapter also provides several examples that
you can use as starting points for controls of your own.

Chapter 23, “Drag and Drop, and the Clipboard,” explains how a Visual Basic program can
support drag-and-drop operations. It tells how your program can start a drag to another
application, respond to drag operations started by another application, and receive a drop from
another application. This chapter also explains how you can copy data to and from the clipboard.
Using the clipboard is similar to certain types of drag-and-drop operations, so these topics fit
naturally in one chapter.
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Chapter 24, “UAC Security,” describes the User Account Control (UAC) security model used by the
Vista and Windows 7 operating systems. With UAC security, all users run with reduced “normal”
user privileges. If a program must perform tasks requiring administrator permissions, a UAC dialog
box allows you to elevate the application’s privilege level. This chapter describes UAC security and
explains how you can mark a program for privilege elevation.

Part lll: Object-Oriented Programming

This part explains fundamental concepts in object-oriented programming (OOP) with Visual Basic.
It also describes some of the more important classes and objects that you can use when building an
application.

Chapter 25, “OOP Concepts,” explains the fundamental ideas behind object-oriented programming
(OOP). It describes the three main features of OOP: encapsulation, polymorphism, and inheritance. It
explains the benefits of these features, and tells how you can take advantage of them in Visual Basic.

Chapter 26, “Classes and Structures,” explains how to declare and use classes and structures. It

explains what classes and structures are, and it describes their differences. It shows the basic decla-
ration syntax and tells how to create instances of classes and structures. It also explains some of the
trickier class issues such as private class scope, declaring events, and shared variables and methods.

Chapter 27, “Namespaces,” explains namespaces. It discusses how Visual Studio uses namespaces
to categorize code and to prevent name collisions. It describes a project’s root namespace, tells how
Visual Basic uses namespaces to resolve names (such as function and class names), and demonstrates
how you can add namespaces to an application yourself.

Chapter 28, “Collection Classes,” explains classes included in Visual Studio that you can use to
hold groups of objects. It describes the various collection, dictionary, queue, and stack classes; tells
how to make strongly typed versions of those classes; and gives some guidance on deciding which
class to use under different circumstances.

Chapter 29, “Generics,” explains templates you can use to build new classes designed to work with
specific data types. For example, you can build a generic binary tree, and then later use it to build
classes to represent binary trees of customer orders, employees, or work items.

Part IV: Graphics

The chapters in this part of the book describe graphics in Visual Basic 2010. They explain the
Graphics Device Interface+ (GDI+) routines that programs use to draw images in Visual Basic. They
explain how to draw lines and text; how to draw and fill circles and other shapes; and how to load,
manipulate, and save bitmap images. This part also explains how to generate printed output and
how to send reports to the screen or to the printer.

Chapter 30, “Drawing Basics,” explains the fundamentals of drawing graphics in Visual Basic 2010.
It describes the graphics namespaces and the classes they contain. It describes the most important
of these classes, Graphics, in detail. It also describes the Paint event handler and other events that a
program should use to keep its graphics up to date.
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Chapter 31, “Brushes, Pens, and Paths,” explains the most important graphics classes after
Graphics: Pen and Brush. It tells how you can use Pens to draw solid lines, dashed lines, lines with
custom dash patterns, and lines with custom lengthwise stripe patterns. It tells how to use Brushes
to fill areas with colors, hatch patterns, linear color gradients, color gradients that follow a path,
and tiled images. This chapter also describes the GraphicsPath class, which represents a series of
lines, shapes, curves, and text.

Chapter 32, “Text,” explains how to draw strings of text. It shows how to create different kinds of
fonts, determine exactly how big text will be when drawn in a particular font, and use GDI+ func-
tions to make positioning text simple. It shows how to use a StringFormat object to determine how
text is aligned, wrapped, and trimmed, and how to read and define tab stops.

Chapter 33, “Image Processing,” explains how to load, modify, and save image files. It shows how to

read and write the pixels in an image, and how to save the result in different file formats such as BMP,
GIF, and JPEG. It tells how to use images to provide auto-redraw features, and how to manipulate an
image pixel-by-pixel, both using a Bitmap’s GetPixel and SetPixel methods and using “unsafe” access
techniques that make pixel manipulation much faster than is possible with normal GDI+ methods.

Chapter 34, “Printing,” explains different ways that a program can send output to the printer. It
shows how you can use the PrintDocument object to generate printout data. You can then use the
PrintDocument to print the data immediately, use a PrintDialog control to let the user select the
printer and set its characteristics, or use a PrintPreviewDialog control to let the user preview the
results before printing.

Part V: Interacting with the Environment

The chapters in this part of the book explain how an application can interact with its environ-
ment. They show how the program can save and load data in external sources (such as the System
Registry, resource files, and text files); work with the computer’s screen, keyboard, and mouse; and
interact with the user through standard dialog controls.

Chapter 35, “Configuration and Resources,” describes some of the ways that a Visual Basic
program can store configuration and resource values for use at runtime. Some of the most useful of
these include environment variables, the Registry, configuration files, and resource files.

Chapter 36, “Streams,” explains the classes that a Visual Basic application can use to work with
stream data. Some of these classes are FileStream, MemoryStream, BufferedStream, TextReader,
and TextWriter.

Chapter 37, “File-System Objects,” describes classes that let a Visual Basic application interact with
the file system. These include classes such as Directory, Directorylnfo, File, and FileInfo that make it
easy to create, examine, move, rename, and delete directories and files.

Chapter 38, “Windows Communication Foundation,” describes the Windows Communication
Foundation (WCF), a library and set of tools that make building service-oriented applications easier.
This chapter explains how to use new WCF attributes to easily define a service, how to use configu-
ration files to configure the service, and how to use WCF tools to consume the service.
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Chapter 39, “Useful Namespaces,” describes some of the more useful namespaces defined by the
.NET Framework. It provides a brief overview of some of the most important System namespaces
and gives more detailed examples that demonstrate regular expressions, XML, cryptography, reflec-
tion, threading, parallel programming, and Direct3D.

Part VI: Appendixes

The book’s appendixes provide a categorized reference of the Visual Basic 2010 language. You can
use them to quickly review the syntax of a particular command or refresh your memory of what a
particular class can do. The chapters earlier in the book give more context, explaining how to per-
form specific tasks and why one approach might be better than another.

Appendix A, “Useful Control Properties, Methods, and Events,” describes properties, methods, and
events that are useful with many different kinds of controls.

Appendix B, “Variable Declarations and Data Types,” summarizes the syntax for declaring vari-
ables. It also gives the sizes and ranges of allowed values for the fundamental data types.

Appendix C, “Operators,” summarizes the standard operators such as +, <<, OrElse, and Like. It
also gives the syntax for operator overloading.

Appendix D, “Subroutine and Function Declarations,” summarizes the syntax for subroutine,
function, and property procedure declarations. It also summarizes the syntax for using
lambda functions and statements (subroutines).

Appendix E, “Control Statements,” summarizes statements that control program flow, such as If
Then, Select Case, and looping statements.

Appendix F, “Error Handling,” summarizes both structured and classic error handling. It
describes some useful exception classes and gives an example showing how to build a custom
exception class.

Appendix G, “Windows Forms Controls and Components,” summarizes standard Windows Forms
controls and components provided by Visual Basic 2010. It explains the properties, methods, and
events that I have found most useful when working with these components.

Appendix H, “WPF Controls,” summarizes the most useful WPF controls.

Appendix I, “Visual Basic Power Packs,” lists some additional tools that you can download to make
Visual Basic development easier. This appendix describes some Visual Basic 6 compatibility tools
provided by Microsoft, and some GotDotNet Power Packs that contain useful controls built in
Visual Basic 2003.

Appendix J, “Form Objects,” describes forms. In a very real sense, forms are just another type of
control, but they play such a key role in Visual Basic applications that they deserve special attention
in their own appendix.

Appendix K, “Classes and Structures,” summarizes the syntax for declaring classes and structures,
and defining their constructors and events.
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Appendix L, “LINQ,” summarizes LINQ and PLINQ syntax.
Appendix M, “Generics,” summarizes the syntax for declaring generic classes.

Appendix N, “Graphics,” summarizes the objects used to generate graphics in Visual Basic 2010. It
covers the most useful graphics namespaces.

Appendix O, “Useful Exception Classes,” lists some of the more useful exception classes defined by
Visual Basic. You may want to throw these exceptions in your own code.

Appendix P, “Date and Time Format Specifiers,” summarizes specifier characters that you can use to
format dates and times. For example, they let you display a time using a 12-hour or 24-hour clock.

Appendix Q, “Other Format Specifiers,” summarizes formatting for numbers and enumerated types.

Appendix R, “The Application Class,” summarizes the Application class that provides properties
and methods for controlling the current application.

Appendix S, “The My Namespace,” describes the My namespace, which provides shortcuts to
useful features scattered around other parts of the .NET Framework. It provides shortcuts for work-
ing with the application, computer hardware, application forms, resources, and the current user.

Appendix T, “Streams,” summarizes the Visual Basic stream classes such as Stream, FileStream,
MemoryStream, TextReader, CryptoStream, and so forth.

Appendix U, “File-System Classes,” summarizes methods that an application can use to learn about
and manipulate the file system. It explains classic Visual Basic methods such as FreeFile, WriteLine,
and ChDir, as well as newer .NET Framework classes such as FileSystem, Directory, and File.

Appendix V, “Index of Examples,” briefly describes the more than 400 example programs that are
available for download on the book’s web site. You can use this list to see which programs demon-
strate particular techniques.

BONUS CHAPTERS

Occasionally I will post bonus chapters on the book’s web site to cover topics that didn’t fit into this
book (despite its size) or to cover new technologies and techniques.

In particular, Crystal Reports is a useful reporting tool that Visual Basic developers have used for
years. Unfortunately, Crystal Reports 2010 won’t be ready until after Visual Studio 2010 is released
and that will be too late for this book. Rather than using the older version of Crystal Reports and
including a chapter that will become obsolete almost immediately, I'm going to provide that chap-
ter online when Crystal Reports 2010 is available. (Hopefully a free edition of Crystal Reports for
Visual Studio users should be available sometime in the second quarter of 2010.)

To learn when bonus chapters are available, check the book’s web site or email me at RodStephense
vb-helper.con. If you'd like more information about some other topic, feel free to drop me a note.
If I think others will find the information useful, I may be able to write another bonus chapter or
some examples. I can at least give you some hints and pointers that you may find helpful.
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HOW TO USE THIS BOOK

If you are an experienced Visual Basic .NET programmer, you may want to skim the language
basics covered in the first parts of the book. You may find a few new features that have appeared in
Visual Basic 2010, so you probably shouldn’t skip these chapters entirely, but most of the basic
language features are the same as in previous versions.

Intermediate programmers and those with less experience with Visual Basic .NET should take these
chapters a bit more slowly. The chapters in Part III, “Object-Oriented Programming,” cover particu-
larly tricky topics. Learning all the variations on inheritance and interfaces can be rather confusing.

Beginners should spend more time on these first chapters because they set the stage for the mate-
rial that follows. It will be a lot easier for you to follow a discussion of file management or regular
expressions if you are not confused by the error-handling code that the examples take for granted.

Programming is a skill best learned by doing. You can pick up the book and read through it quickly
if you like (well, as quickly as you can given how long it is), but the information is more likely to
stick if you open the development environment and experiment with some programs of your own.

Learning by doing may encourage you to skip sections of the book. For example, Chapter 1 covers
the IDE in detail. After you've read for a while, you may want to skip some sections and start exper-
imenting with the environment on your own. I encourage you to do so. Lessons learned by doing
last longer than those learned by reading. Later, when you have some experience with the develop-
ment environment, you can go back and examine Chapter 1 in more detail to see if you missed any-
thing during your experimentation.

The final part of the book is a Visual Basic 2010 reference. These appendixes present more concise,
categorized information about the language. You can use these appendixes to recall the details of spe-
cific operations. For example, you can read Chapter 8 to learn which controls are useful for different
purposes. Then use Appendix G to learn about specific controls’ properties, methods, and events.

Throughout your work, you can also refer to the appendixes to get information on specific classes,
controls, and syntax. For example, you can quickly find the syntax for declaring a generic class in
Appendix M. If you need more information on generics, you can find it in Chapter 29 or the online
help. If you just need to refresh your memory of the basic syntax, however, scanning Appendix M
will be faster.

NECESSARY EQUIPMENT

To read this book and understand the examples, you will need no special equipment. To use Visual
Basic 2010 and to run the examples found on the book’s web page, you need any computer that can
reasonably run Visual Basic 2010. That means a reasonably modern, fast computer with a lot of
memory. See the Visual Basic 2010 documentation for Microsoft’s exact requirements and recom-
mendations. (I use a dual-core 1.83 GHz Intel Core 2CPU system with 2 GB of memory and 100 GB
of hard disk space running Windows 7 Ultimate. It’s a nice system but I wouldn’t say it’s overkill.)
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To build Visual Basic 2010 programs, you will also need a copy of Visual Basic 2010. Don’t bother
trying to run the examples shown here if you have a pre-.NET version of Visual Basic such as
Visual Basic 6. The changes between Visual Basic 6 and Visual Basic .NET are huge, and

many Visual Basic .NET concepts don’t translate well into Visual Basic 6. With some experience
in C#, it would be much easier to translate programs into that language.

Much of the Visual Basic 2010 release is compatible with Visual Basic 2008 and earlier versions of
Visual Basic .NET, however, so you can make many of the examples work with earlier versions

of Visual Basic .NET. You will not be able to load the example programs downloaded from the
book’s web site, however. You will need to open the source code files in an editor such as WordPad
and copy and paste the significant portions of the code into your version of Visual Basic.

To use UAC security, you must have UAC security installed on your computer. UAC is installed and
activated by default in the Windows Vista and Windows 7 operating systems.

CONVENTIONS

To help you get the most from the text and keep track of what’s happening, a number of conventions
have been used throughout the book.

As for styles in the text:
> Important words are highlighted when they are introduced.
>  Keyboard strokes are shown like this: Ctrl+A.
> File names, URLs, and code within the text are shown like this: persistence.properties.
>

Code is presented in the following two different ways:

We use a monofont type for most code examples.
We use bolded type to emphasize code that's particularly important in the
present context.

SOURCE CODE

As you work through the examples in this book, you may choose either to type in all the code man-
ually or to use the source code files that accompany the book. Many of the examples show only the
code that is relevant to the current topic and may be missing some of the extra details that you need
to make the example work properly.

All of the source code used in this book is available for download at www.wrox.com. Once at the site,
simply locate the book’s title (either by using the Search box or by using one of the title lists) and click
the Download Code link on the book’s detail page to obtain all the source code for the book.
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FIND IT FAST

Because many books have similar titles, you may find it easiest to locate the book
by its ISBN: 978-0-470-49983-2.

Once you download the code, just decompress it with your favorite compression tool. Alternatively,
you can go to the main Wrox code download page at www.wrox.com/dynamic/books/download
.aspx to see the code available for this book and all other Wrox books.

You can also download the book’s source code from its web page on my VB Helper web site
www . vb-helper.com/vb_prog_ref.htm. That page allows you to download all of the book’s code
in one big chunk or by individual chapter.

ERRATA

We make every effort to ensure that there are no errors in the text or in the code. However, no one
is perfect, and mistakes do occur. If you find an error in one of my books, like a spelling mistake or
faulty piece of code, I would be very grateful for your feedback. By sending in errata you may save
another reader hours of frustration and at the same time you will be helping me provide even higher
quality information.

To find the errata page for this book, go to www.wrox.com and locate the title using the Search box
or one of the title lists. Then, on the book details page, click the Book Errata link. On this page you
can view all errata that have been submitted for this book and posted by Wrox editors. A complete
book list including links to each book’s errata is also available at www.wrox.com/misc-pages/
booklist.shtml.

If you don’t spot “your” error on the Book Errata page, go to www.wrox.com/contact/
techsupport.shtml and complete the form there to send us the error you have found. We’ll check
the information and, if appropriate, post a message to the book’s errata page and fix the problem in
subsequent editions of the book.

P2P.WROX.COM

For author and peer discussion, join the P2P forums at p2p.wrox.com. The forums are a Web-based
system for you to post messages relating to Wrox books and related technologies and interact with
other readers and technology users. The forums offer a subscription feature to e-mail you topics

of interest of your choosing when new posts are made to the forums. Wrox authors, editors, other
industry experts, and your fellow readers are present on these forums.
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At p2p.wrox.com you will find a number of different forums that will help you not only as you read
this book, but also as you develop your own applications. To join the forums, just follow these steps:

1. Goto p2p.wrox.com and click the Register link.
2. Read the terms of use and click Agree.

3. Complete the required information to join as well as any optional information you wish to
provide and click Submit.

4. You will receive an e-mail with information describing how to verify your account and com-
plete the joining process.

JOIN THE FUN

You can read messages in the forums without joining P2P, but in order to post your
OWN messages, you must join.

Once you join, you can post new messages and respond to messages other users post. You can read
messages at any time on the Web. If you would like to have new messages from a particular forum
e-mailed to you, click the Subscribe to this Forum icon by the forum name in the forum listing.

For more information about how to use the Wrox P2P, be sure to read the P2P FAQs for answers to
questions about how the forum software works as well as many common questions specific to P2P
and Wrox books. To read the FAQs, click the FAQ link on any P2P page.

Using the P2P forums allows other readers to benefit from your questions and any answers they
generate. I monitor my book’s forums and respond whenever I can help.

If you have other comments, suggestions, or questions that you don’t want to post to the forums,
feel free to e-mail me at RodStephens@vb-helper.com with your comments, suggestion, or ques-
tions. I can’t promise to solve every problem but I’ll try to help you out if I can.

IMPORTANT URLs

Here’s a summary of important URLs:

>  www.vb-helper.com — My VB Helper web site. Contains thousands of tips, tricks, and
examples for Visual Basic developers.

> www.vb-helper.com/vb_prog reg.htm — This book’s web page on my VB Helper
web site. Includes basic information, code downloads, errata, and more.

>  p2p.wrox.com — Wrox P2P forums.

www . wrox.com — The Wrox web site. Contains code downloads, errata, and other
information. Search for the book by title or ISBN.

>  RodStephens@vb-helper.com — My e-mail address. I hope to hear from you!

liv
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Introduction to the IDE

The chapters in the first part of this book describe the Visual Studio integrated development
environment (IDE). They explain the most important windows, menus, and toolbars that
make up the environment, and show how to customize them to suit your needs. They explain
some of the tools that provide help while you are writing Visual Basic applications and how to
use the IDE to debug programs.

Even if you are an experienced Visual Basic programmer, you should at least skim this mate-
rial. The IDE is extremely complex and provides hundreds (if not thousands) of commands,
menus, toolbars, windows, context menus, and other tools for editing, running, and debug-
ging Visual Basic projects. Even if you have used the IDE for a long time, there are sure to be
some features that you have overlooked.

SNEAKY SHORTCUTS

When I teach Visual Basic, for example, I cover the IDE’s keyboard shortcuts (such
as Alt+Space to open IntelliSense, and Ctrl+C, Ctrl+X, and Ctrl+V to copy, cut, and
paste) early in the class. The students don’t really write enough code to take full
advantage of these tools for several weeks, however, so we revisit the topic later.

These chapters describe some of the most important of those features, and you may discover
something useful that you’ve never noticed before.

Even after you’ve read these chapters, you should periodically spend some time wandering
through the IDE to see what you’ve missed. Every month or so, spend a few minutes exploring
little-used menus and right-clicking things to see what their context menus contain. As you
become a more proficient Visual Basic programmer, you will find uses for tools that you may
have dismissed or not understood before.
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It’s also useful to save links to tips you discover online. You can make a Visual
Basic Tips folder in your browser’s favorites list to make finding the tips again
later easier.

This chapter explains how to get started using the IDE. It tells how to configure the IDE for
different kinds of development. It explains Visual Basic projects and solutions, and shows how to
create, run, and save new projects. This chapter is mostly an introduction to the chapters that
follow. The other chapters in this part of the book provide much more detail about particular tasks,
such as using the IDE’s menus, customizing menus and toolbars, and using the Windows Forms
Designer to build forms.

DIFFERENT IDE APPEARANCES

Before you start reading about the IDE and viewing screen shots, it’s important to understand
that the Visual Studio IDE is extremely customizable. You can move, hide, or modify the menus,
toolbars, and windows; create your own toolbars; dock, undock, or rearrange the toolbars and
windows; and change the behavior of the built-in text editors (change their indentation, colors for
different kinds of text, and so forth).

These chapters describe the basic Visual Studio development environment as it
is initially installed. After you’ve moved things around to suit your needs, your
IDE may look nothing like the pictures in this book. If a figure doesn’t look
exactly like what you see on your computer, don’t worry too much about it.

To avoid confusion, you should probably not customize the IDE’s basic menus and toolbars too
much. Removing the help commands from the Help menu and adding them to the Edit menu will
only cause confusion later. Moving or removing commands will also make it more difficult to follow
the examples in this and other books, and will make it more difficult to follow instructions given

by others who might be able to help you when you have problems.

Instead of making drastic changes to the default menus and toolbars, hide the menus and toolbars
that you don’t want and create new customized toolbars to suit your needs. Then you can find the
original standard toolbars if you decide you need them later. Chapter 3, “Customization,” has more
to say about rearranging the IDE’s components.

The screens shown in this book may not look exactly like the ones on your system for several other
reasons as well. Visual Studio looks different on different operating systems. The figures in this
book were taken on a computer running Windows 7 so they display the Windows 7 look and feel.
You may see a different appearance, even if you are using Windows 7 and you have selected another
style. Additionally, some commands may not behave exactly the same way on different operating
systems.
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SECURITY OBSCURITY

Windows Vista and Windows 7 use the User Account Control (UAC) security model.
When you first log on, all accounts get a normal level of user privileges. Later, when
you try to run certain applications that require increased permissions, a UAC privi-
lege elevation dialog box appears where you can enter an administrator password.
The examples in this book were tested using a normal user account, so you should
not see that dialog while running them, but you may see it if you use other develop-
ment tools. Chapter 24, “UAC Security,” provides more details about UAC.

Visual Studio will also look different depending on which version you have installed. The free
Visual Basic 2010 Express Edition product has fewer tools than other editions such as the high-end
Team Suite. The figures in this book were captured while using Team Suite, so if you have another
version, you may not see all of the tools shown here. Menu items, toolbars, and other details may
also be slightly different for different versions. Usually you can find moved items with a little
digging through the menus and customizations.

FOR MORE INFORMATION

You can learn about Visual Studio’s free Express editions at www.microsoft .com/
express. Learn about Visual Basic in general at the Visual Basic home page

msdn.microsoft.com/vbasic.

Finally, you may be using different configuration settings from the ones used while writing this
book. You can configure Visual Studio to use settings customized for developing projects using
Visual Basic, C#, Web tools, and other technologies. This book assumes your installation is con-
figured for Visual Basic development and the screen shots may look different if you have selected a
different configuration. The following section says more about different IDE configurations and tells
how you can select a particular configuration.

IDE CONFIGURATIONS

When you install it, Visual Studio asks you what kind of development settings you want to use. The
most obvious choice for a Visual Basic developer is Visual Basic Development Settings. This choice
customizes Visual Studio to work more easily with Visual Basic, and is a good selection if you will
focus on Visual Basic development.

Another reasonable choice is General Development Settings. This option makes Visual Studio
behave more like Visual Studio 2003. It’s a good choice if you’re used to Visual Studio 2003, or
if you expect to use other Visual Studio languages, such as C#, somewhat regularly because these
settings are fairly effective for C# development as well as Visual Basic development.
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This book assumes that you have configured Visual Studio for Visual Basic development. If you have
chosen a different configuration, some of the figures in this book may look different from what you
see on your screen. Some of the menu items available may be slightly different, or may appear in

a different order. Usually, the items are available somewhere, but you may have to search a bit to
find them.

If you later decide that you want to switch configurations, open the Tools menu and select Import
and Export Settings to display the Import and Export Settings Wizard. Select the “Reset all set-
tings” option button and click Next. On the second page, tell the wizard whether to save your
current settings and click Next. On the wizard’s final page (shown in Figure 1-1), select the type of
configuration you want and click Finish. When the wizard is done, click Close.

FIGURE 1-1: Use the Tools menu’s Import and Export Settings
command to change the Visual Studio configuration.

PROJECTS AND SOLUTIONS

Before you can understand how to use the IDE effectively to manage Visual Basic projects and solu-
tions, you should know what projects and solutions are.

A project is a group of files that produces some specific output. This output may be a compiled
executable program, a dynamic-link library (DLL) of classes for use by other projects, or a control
library for use on other Windows forms.
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A solution is a group of one or more projects that should be managed together. For example,
suppose that you are building a server application that provides access to your customer order data-
base. You are also building a client program that each of your sales representatives will use to query
the server application. Because these two projects are closely related, it might make sense to manage
them in a single solution. When you open the solution, you get instant access to all the files in

both projects.

Both projects and solutions can include associated files that are useful for building the application
but that do not become part of a final compiled product. For example, a project might include the
application’s proposal and architecture documents. These are not included in the compiled code, but
it is useful to associate them with the project so they are easy to find, open, and edit while working
on the project.

When you open the project, Visual Studio lists those documents along with the program files. If
you double-click one of these documents, Visual Studio opens the file using an appropriate applica-
tion. For example, if you double-click a file with a .doc, .docm, or .docx extension, Visual Studio
normally opens it with Microsoft Word.

To associate one of these files with a project or solution, right-click the project file at the top of the
Solution Explorer (more on the Solution Explorer shortly). Select the Add command’s New Item
entry, and use the resulting dialog box to select the file you want to add.

CUT OUT CLUTTER

Although you can add any file to a project or solution, it’s not a good idea to cram
dozens of unrelated files into the same project. Although you may sometimes want
to refer to an unrelated file while working on a project, the extra clutter brings
additional chances for confusion. It will be less confusing to shrink the Visual
Basic IDE to an icon and open the file using an external editor such as Word or
WordPad. If you won’t use a file very often with the project, don’t add it.

STARTING THE IDE

When you launch Visual Studio, it initially displays the Start Page shown in Figure 1-2 by default.
The Start Page’s Recent Projects section lists projects that you have worked on recently and provides
links that let you open an existing project or web site, or create a new project or web site. The Get
Started tab contains links to help topics that may be useful to beginners.

The Get Started tab is further divided into sub-topics such as Welcome, Windows, Web, Cloud, and
so forth. Click on those sub-topics for more specific information.
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FIGURE 1-2: By default, Visual Studio initially displays the Start Page.

Click on the Guidance and Resources tab to see general development topics such as those shown
in Figure 1-3. Use the MSDN Resources sub-topic to learn more about MSDN subscriptions and
downloads. Use the Additional Tools sub-topic to learn more about additional extensions to Visual
Studio.

Click on the Latest News tab to see the RSS feed shown in Figure 1-3. This feed lists current articles
and stories about Visual Studio development. To change the feed, simply enter a new URL in the
textbox.

Use the links on the left to open or create new projects. Click New Project to start a new project.
Click Open Project to browse for a project to open. Click one of the Recent Project links to quickly
open a project that you have recently edited.

Instead of displaying the Start Page, Visual Studio can take one of several other actions when it
starts. To change the startup action, open the Tools menu and select Options. Then select the
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“Show all settings” check box so you can see all of the options and open the Environment folder’s
Startup item. In the “At startup” dropdown, you can select one of the following options:

> Open Home Page
Load last loaded solution
Show Open Project dialog box

Show New Project dialog box

Y Y VY VY

Show empty environment
> Show Start Page
Pick one and click OK.

FIGURE 1-3: The Guidance and Resources tab provides general information about
development with Visual Studio.
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CREATING A PROJECT

After you open Visual Studio, you can use the Start Page’s New Project link (see Figure 1-4) or the
File menu’s New Project command to open the New Project dialog shown in Figure 1-5.

FIGURE 1-4: The Latest News tab shows current articles and information from
a Microsoft RSS feed.

FIGURE 1-5: The New Project dialog lets you start a new project.
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Use the Project Types tree view on the left to select the project category that you want. Then select
a specific project type on the right. In Figure 1-5, the Windows Forms Application project type is
selected. Enter a name for the new project in the text box at the bottom.

After you fill in the new project’s information, click OK to create the project.

Visual Studio initially creates the project in a temporary directory. If you close
the project without saving it, it is discarded.

Figure 1-6 shows the IDE immediately after starting a new Windows Forms Application project.
Remember that the IDE is extremely configurable, so it may not look much like Figure 1-6 after you
have rearranged things to your liking (and I’ve arrange things to my liking here).

FIGURE 1-6: Initially a new project looks more or less like this.
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The key pieces of the IDE are labeled with numbers in Figure 1-6. The following list briefly
describes each of these pieces:

1.

7.

Menus — The menus contain standard Visual Studio commands. These generally
manipulate the current solution and the modules it contains, although you can customize
the menus as needed. Visual Studio changes the menus and their contents depending on the
object you currently have selected. In Figure 1-6, a Form Designer (marked with the number
4) is open so the IDE is displaying the menus for editing forms.

Toolbars — Toolbars contain tools that you can use to perform frequently needed actions.
The same commands may be available in menus, but they are easier and faster to use in
toolbars. The IDE defines several standard toolbars such as Formatting, Debug, and Image
Editor. You can also build your own custom toolbars to hold your favorite tools. Visual
Studio changes the toolbars displayed to match the object you currently have selected.

Toolbox — The Toolbox contains tools appropriate for the item that you currently have
selected and for the project type that you are working on. In Figure 1-6, a Form Designer
is selected in a Windows Forms application so the Toolbox contains tools appropriate for a
Form Designer. These include Windows Forms controls and components, plus tools in the
other Toolbox tabs.

Form Designer — A Form Designer lets you modify the graphical design of a form. Select a
control tool from the Toolbox, and click and drag to place an instance of the control on
the form. Use the Properties window (marked with the number 6) to change the new
control’s properties. In Figure 1-6, no control is selected, so the Properties window shows
the form’s properties rather than a control’s.

Solution Explorer — The Solution Explorer lets you manage the files associated with the
current solution. For example, in Figure 1-6, you could select Form1.vb in the Project
Explorer and then click the View Code button (the third icon from the right at the top of
the Solution Explorer) to open the form’s code editor. You can also right-click an object
in the Solution Explorer to get a list of appropriate commands for that object.

Properties — The Properties window lets you change an object’s properties at design time.
When you select an object in a Form Designer or in the Solution Explorer, the Properties
window displays that object’s properties. To change a property’s value, simply click the
property and enter the new value.

Error List — The Error List window shows errors and warnings in the current project. For
example, if a variable is used but not declared, this list will say so.

If you look at the bottom of Figure 1-6, you’ll notice that the Error List window has a series of tabs.
The Task List tab displays items flagged for further action such as To Do items. The Command
window lets you execute Visual Studio commands, such as those invoked by menu items. The
Immediate window lets you type and execute Visual Basic commands, possibly while a program is
running, but paused.
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The Output tab shows output printed by the application. Usually an application interacts with the
user through its forms and dialog boxes, but it can display information here, usually to help you
debug the code. The Output window also shows informational messages generated by the IDE. For
example, when you compile an application, the IDE sends messages here to tell you what it is doing
and whether it succeeded.

WHAT WINDOWS?

If you don’t see the Error List, Task List, and other windows, they are probably
hidden. You can display many of them by selecting the appropriate item in the View
menu. Commands to display some of the more exotic windows are located in other
menus, such as the View menu’s Other Windows submenu and the Debug menu’s
Windows submenu.

As soon as you create a new project, it is ready to run. If you open the Debug menu and select Start
Debugging, the program will run. It displays only an empty form containing no controls, but the
form automatically handles a multitude of mundane windowing tasks for you.

READY TO RUN

If you’re using the Visual Basic environment settings, you can simply press F5 to
start the program.

Before you write a single line of code, the form lets the user resize, minimize, restore, maximize,
and close the form. The form draws its title bar, borders, and system menu, and repaints itself as
needed when it is covered and restored. The operating system also automatically handles many
tasks such as displaying the form in the Windows taskbar and Task Manager. Vista automatically
generates thumbnail previews for its Flip and Flip 3D tools that you display by pressing Alt+Tab or
Windows+Tab, respectively. Visual Basic and the operating system do a ton of work for you before
you even touch the project!

The form contains no controls, can’t open files, doesn’t process data, in fact doesn’t really do
anything unique but a lot of the setup is done for you. It handles the windowing chores for you
so you can focus on your particular problem.

SAVING A PROJECT

Later chapters explain in depth how to add controls to a form and how to write code to
interact with the form. For now, suppose you have built a project complete with controls
and code.
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If you try to close Visual Studio or start a new project, the
dialog shown in Figure 1-7 appears. Click Save to make
the Save Project dialog shown in Figure 1-8 appear. Click
Discard to throw away the existing project and start a new
one. Click Cancel to continue editing the current project.

As you work with the new project, Visual Studio saves its
form definitions and code in a temporary location. Each‘ time g4 dio or starting a new project,
you run the program, Visual Studio updates the files so it you must decide what to do with the
doesn’t lose everything if it crashes. The files are still tempo-  previous project.

rary, however.

FIGURE 1-7: Before closing Visual

When you are ready to make the new project permanent, open the File menu and select Save All to
display the Save Project dialog shown in Figure 1-8.

The Name field shows the name that you originally gave the project when you created it. Verify that
the name is okay or change it.

Next, enter the location where you want the project saved. The default location is similar to the
rather non-intuitive value shown in Figure 1-8. (This image was taken while I was logged in as the
user named Developer. When you save a project, the “Developer” part of the location would be
replaced with your user name.)

Be sure to pick a good location before you click Save. The next time you build a project, the default
will be the location you specify now so you won’t need to be quite as careful in the future, assuming
you want to build a lot of projects in the same directory.

If you check the “Create directory for solution” box, Visual Studio enables the Solution Name text
box and adds an extra directory above the project directory to hold the solution. This is most useful
when you want to include more than one project in a single solution. For example, you might want
several projects in the same solution to sit in a common solution directory.

After you have entered the project name and location, and optionally specified a separate solution
directory, click Save.

FIGURE 1-8: Use this dialog to save a new project.
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“SAVE AS” SURVIVAL SKILLS

The File menu’s Save As commands let you save particular pieces of the solu-

tion in new files. For example, if you have a project named OfficeArrangerMain
selected in Project Explorer, the File menu contains a command named “Save
OfficeArrangerMain As.” This command lets you save the project file with a

new name. Unfortunately it doesn’t make a new copy of the whole project; it just
makes a copy of the project file. That file contains information about the project
on a high level such as references used by the project, files imported by the project,
and the names of the forms included in the project. It does not contain the forms
themselves.

Many beginners try to use the File menu’s Save As commands to make copies of a
project or a solution but it doesn’t work. Instead, use Windows Explorer to find the
directory containing the whole project or solution and make a copy of the entire
directory.

Similarly, if you want to back up a project or send someone a copy of a project, you
need to use the entire solution directory, not just one or two of the many files that
Visual Studio creates.

SUMMARY

This chapter explains how to get started using the Visual Studio integrated development environ-
ment. It shows how to configure the IDE for different kinds of development and explains that
different configurations might make your version of Visual Studio look different from the screen
shots shown in this book. It explains what Visual Basic projects and solutions are, and shows how
to create, run, and save a new project.

The next few chapters describe parts of the IDE in greater detail. Chapter 2, “Menus, Toolbars, and
Windows,” describes the commands available in the IDE and the menus, toolbars, and secondary
windows that hold them.






Menus, Toolbars, and Windows

The Visual Studio IDE is incredibly powerful and provides hundreds of tools for building
and modifying projects. The price you pay for all of these powerful tools is extra complexity.
Because so many tools are available, it can take some digging to find the tool you want, even
if you know exactly what you need.

This chapter describes the menus, toolbars, and windows that contain the tools provided
by the IDE. It explains some of the most useful tools provided by the IDE and tells where to
find them, provided you haven’t moved them while customizing the IDE.

This chapter also tells how you can customize the menus and toolbars to give you easy access
to the commands that you use most frequently and how to hide those that you don’t need.

MENUS

The IDE’s menus contain standard Visual Studio commands. These are generally commands that
manipulate the project and the modules it contains. Some of the concepts are similar to those
used by any Windows application (File &> New, File = Save, Help = Contents), but many of the
details are specific to Visual Studio programming, so the following sections describe them in a bit
more detail.

The menus are customizable, so you can add, remove, and rearrange the menus and the items
they contain. This can be quite confusing, however, if you later need to find a command that
you have removed from its normal place in the menus. Some developers place extra commands
in standard menus, particularly the Tools menu, but it is generally risky to remove standard
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menu items. Usually it is safest to leave the standard menus alone and make custom menus and tool-
bars to hold customizations. For more information on this, see Chapter 3, “Customization.”

Many of the menus’ most useful commands are also available in other ways. Many provide key-
board shortcuts that make using them quick and easy. For example, Ctrl+N opens the New Project
dialog box just as if you had selected the File & New Project menu command. (If you are using the
C# or General Development settings, the shortcut is Ctrl+Shift+N.) If you find yourself using the
same command very frequently, look in the menu and learn its keyboard shortcut to save time later.

Many menu commands are also available in standard toolbars. For example, the Debug toolbar con-
tains many of the same commands that are in the Debug menu. If you use a set of menu commands
frequently, you may want to display the corresponding toolbar to make using the commands easier.

Visual Studio also provides many commands through context menus. For example, if you right-click
a project in the Solution Explorer, the context menu includes an Add Reference command that dis-
plays the Add Reference dialog box just as if you had invoked Project &> Add Reference. Often it is
easier to find a command by right-clicking an object related to whatever you want to do than it is to
wander through the menus.

The following sections describe the general layout of the standard menus and briefly explain their
most important commands. You might want to open the menus in Visual Studio as you read these
sections, so you can follow along.

MOVING MENUS

Visual Studio displays different menus and different commands in menus depend-
ing on what editor is active. For example, when you have a form open in the
Windows Forms Designer, Visual Studio displays a Format menu that you can use
to arrange controls on the form. When you have a code editor open, the Format
menu is hidden because it doesn’t apply to code.

File

The File menu contains commands that deal with creating, opening, saving, and closing projects and
project files. The following list describes the most important commands contained in the File menu
and its submenus:

> New Project — This command displays the dialog box shown in Figure 2-1. This dialog
box lets you create new Windows applications, class libraries, console applications, control
libraries, and more. Select the type of project yo want to start, enter a project name, and

click OK.
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FIGURE 2-1: The New Project dialog box lets you start various kinds of
new projects.

>  New Web Site — This command lets you start a new web site project. It displays a dialog
box where you can select the type of web site to create from among choices such as ASP
NET Web Site, ASP.NET Web Service, and Empty Web Site.

Open Project — This command lets you open an existing project.
Open Web Site — This command lets you open an existing web site project.

> Open File — This command displays the dialog box shown in Figure 2-2 and lets you
select a file to open. The IDE uses integrated editors to let you edit the new file. For exam-
ple, a simple bitmap editor lets you set a bitmap’s size, change its number of colors, and
draw on it. When you close the file, Visual Studio asks if you want to save it. Note that
this doesn’t automatically add the file to your current project. You can save the file and
use the Project @ Add Existing Item command if you want to do that.
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FIGURE 2-2: The Open File dialog box lets you select files to view
and edit.

> Add — This submenu lets you add new items to the current solution. This submenu’s most
useful commands for Visual Basic developers are New Project and Existing Project, which
add a new or existing Visual Basic project to the current solution.

> Close — This command closes the current editor. For example, if you were editing a form in
the Windows Forms Designer, this command closes the Designer.

> Close Project — This command closes the entire project and all of the files it contains. If
you have a solution open, this command is labeled Close Solution and it closes the entire
solution.

> Save Form1.vb — This command saves the currently open file, in this example, Form1.vb.
Save Form1.vb As — This command lets you save the currently open file in a new file.

> Save All — This command saves all modified files. When you start a new project, the files
are initially stored in a temporary location. This command allows you to pick a directory
where the project should be saved permanently.

>  Export Template — The Export Template command displays the dialog box shown in
Figure 2-3. The Export Template Wizard enables you to create project or item templates
that you can use later when making a new project.
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FIGURE 2-3: The File/Export Template command displays this dia-
log box to help you create project or items templates that you can
easily use in other projects.

> Page Setup and Print — The Page Setup and Print commands let you configure printer
settings and print the current document. These commands are enabled only when it makes
sense to print the current file. For example, they let you print if you have a code editor
open because the code is text but they are disabled while you are using a Windows
Forms Designer.

> Recent Files and Recent Projects and Solutions — The Recent Files and Recent Projects and
Solutions submenus let you quickly reopen files, projects, and solutions that you have used
recently.

Edit

The Edit menu contains commands that deal with manipulating text and other objects. These
include standard commands such as the Undo, Redo, Cut, Copy, Paste, and Delete commands that
you’ve seen in other Windows applications.

The following list describes other important commands contained in the Edit menu:

> Find Symbol — The Find Symbol command lets you search the application for a program
symbol rather than a simple string. You can search for such items as namespaces, types,
interfaces, properties, methods, constants, and variables.

> Quick Find — This command displays a find dialog box where you can search the project
for specific text. A drop-down menu lets you indicate whether the search should include the
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current document, the currently selected text, all open documents, the current project,
or the current solution. Options let you determine such things as whether the text must
match case or whole words.

> Quick Replace — This command displays the same dialog box as the Quick Find
command except with some extra controls. It includes a text box where you can specify
replacement text, and buttons that let you replace the currently found text or all
occurrences of the text.

REGRETFUL REPLACEMENT

Be careful when using Quick Replace. Often it gets carried away and replaces
substrings of larger strings so they don’t make sense anymore. For example,
suppose you want to replace the variable name “hand” with “handed.” If you

let Quick Replace run, it will change Handles clauses into “handedles” clauses,
which will confuse Visual Basic. To reduce the chances of this type of error, keep
the scope of the replacement as small as possible and check the result for weird
side effects.

>  Go To — This command lets you jump to a particular line number in the current file.

Insert File As Text — This command lets you select a file and insert its text into the current
location. This can be useful if the file contains a code snippet.

> Advanced — The Advanced submenu contains commands for performing more complex
document formatting such as converting text to upper- or lowercase, controlling word wrap,
and commenting and uncommenting code.

>  Bookmarks — The Bookmarks submenu lets you add, remove, and clear bookmarks, and
move to the next or previous bookmark. You can use bookmarks to move quickly to specific
pieces of code that you have previously marked.

> QOutlining — The Outlining submenu lets you expand or collapse sections of code, and turn
outlining on and off. Collapsing code that you are not currently editing can make the rest of
the code easier to read.

> IntelliSense — The IntelliSense submenu gives access to IntelliSense features. For example,
its List Members command makes IntelliSense display the current object’s properties,
methods, and events.

> Next Method/Previous Method — The Next Method and Previous Method commands
move to the next or previous method or class in the current document.
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View

The View menu contains commands that let you hide or display different windows and toolbars in
the Visual Studio IDE. The following list describes the View menu’s most useful commands:

>  Code — The Code command opens the selected file in a code editor window. For example,
to edit a form’s code, you can click the form in the Solution Explorer and then select
View & Code.

> Designer — The Designer command opens the selected file in a graphical editor if one is
defined for that type of file. For example, if the file is a form, this command opens the form
in a graphical form editor. If the file is a class or a code module, the View menu hides this
command because Visual Studio doesn’t have a graphical editor for those file types.

> Standard windows — The next several commands in this menu list some explorers, Object
Browser, Error List, Properties window, and Toolbox. These commands restore a previously
hidden window.

> Other Windows — The Other Windows submenu lists other standard menus that are not
listed in the View menu itself. These include the Bookmark window, Class View, Command
window, Document Outline, Output, Task List, Macro Explorer, and many others. Like
the standard windows commands, these commands are useful for recovering lost or hidden
windows.

> Tab Order — If the currently visible document is a Windows Form that contains controls,
the Tab Order command displays the tab order on top of each control. You can click the
controls in the order you want them to have to set their tab orders quickly and easily. (If you
are working with a WPF form, you must set the controls’ TabIndex properties to set their
tab order.)

>  Toolbars — The Toolbars submenu lets you hide or display the currently defined toolbars.
This submenu lists the standard toolbars in addition to any custom toolbars you have
created.

> Full Screen — The Full Screen command hides all toolbars and windows except for any
editor windows that you currently have open. It also hides the Windows taskbar so that the
IDE occupies as much space as possible. This gives you the most space possible for working
with the files you have open. The command adds a small box to the title bar containing a
Full Screen button that you can click to end full-screen mode.

> Property Pages — This command displays the current item’s property pages. For example, if
you select an application in the Solution Explorer, this command displays the application’s
property pages similar to those shown in Figure 2-4.
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FIGURE 2-4: The View menu’s Property Pages command displays an application’s
property pages.

Project

The Project menu contains commands that let you add and remove items to and from the project.
Which commands are available depends on the currently selected item.

The following list describes the most important commands on the Project menu:

>  New items — The first several commands let you add new items to the project. These
commands are fairly self-explanatory. For example, the Add Class command adds a new
class module to the project. Later chapters explain how to use each of these file types.

> Add New Item — The Add New Item command displays the dialog shown in Figure 2-5.
The dialog lets you select from a wide assortment of items such as about boxes, text files,
bitmap files, and class modules.
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FIGURE 2-5: The Project menu’s Add New Item command lets you add a wide
variety of items to the project.

EASY ICONS

You can build an icon, cursor, or other graphical file right inside Visual Studio. Use
the Add New Item command to add the new file. Visual Studio’s built-in editors let
you draw these files, give them transparent backgrounds, and even set a cursor’s
hotspot. (The hotspot is the pixel that determines where the cursor is pointing. For
example, an arrow cursor’s hotspot is the tip of the arrow.)

> Add Existing Item — The Add Existing Item command lets you browse for a file and add
it to the project. This may be a Visual Basic file (such as a module, form, or class), or some
other related file (such as a related document or image file).

> Exclude From Project — This command removes the currently selected item from the
project. Note that this does not delete the file; it just removes it from the project.

>  Show All Files — The Show All Files command makes Solution Explorer list files that are
normally hidden. These include resource files used by forms, and hidden partial classes
such as designer-generated form code. Normally, you don’t need to work with these files,
so they are hidden. Select this command to show them. Select the command again to hide
them again.
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> Add Reference — The Add Reference
command displays the dialog shown in
Figure 2-6. Select the category of the exter-
nal object, class, or library that you want
to find. For a .NET component, select the
NET tab. This is what yow’ll want most of
the time. For a Component Object Model
(COM) component such as an ActiveX
library or control built using Visual Basic 6,
select the COM tab. Select the Projects tab
to add a reference to another Visual Studio
project. Click the Browse tab to manually
locate the file you want to reference.

Scroll through the list of references until
you find the one you want and select it.
You can use Shift+Click and Ctrl+Click to
select more than one library at the same
time. When you have made your selections, click OK to add the references to the project.
After you have added a reference to the project, your code can refer to the reference’s public
objects. For example, if the file MyMathLibrary.dll defines a class named MathTools and
that class defines a public function Fibonacci, a project with a reference to this DLL could
use the following code:

FIGURE 2-6: Use the Add Reference dialog box to
add references to libraries.

Dim math_tools As New MyMathLibrary.MathTools
MessageBox.Show ("Fib(5) = " & math_tools.Fibonacci(5))
> Add Service Reference — The Add

Service Reference command displays

the dialog shown in Figure 2-7.

You can use this dialog to find Web

Services and add references to them so

your project can invoke them across

the Internet. Figure 2-7 shows a ser-

vice reference for the TerraServer map

and aerial photography service. For

more information, go to terraserver

.microsoft.com.

> WindowsApplication1
Properties — This command
displays the application’s property
pages shown in Figure 2-4.

FIGURE 2-7: Use the Add Service Reference dialog to
add references to Web Services.
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Use the tabs on the left of the application’s property pages to view and modify different types of
application settings. You can leave many of the property values at their default values and many can
be set in ways other than the property pages. For example, by default, the Assembly name and Root
namespace values shown in Figure 2-4 are set to the name of the project when you first create it. For
more projects, that’s fine.

Figure 2-8 shows the Compile property page. This page holds four properties that deserve special
mention.

FIGURE 2-8: The Compile tab contains important properties for controlling
code generation.

First, Option Explicit determines whether Visual Basic requires you to declare all variables before
using them. Leaving this option turned off can sometimes lead to subtle bugs. For example, the
following code is intended to print a list of even numbers between 0 and 10. Unfortunately, a
typographical error makes the Debug.WriteLine statement print the value of the variable j not 1.
Because j is never initialized, the code prints out a bunch of blank values. If you set Option Explicit
to On, the compiler complains that the variable j is not declared and the problem is easy to fix.

For 1 = 1 To 10
If 1 Mod 2 = 0 Then Debug.WriteLine(j)
Next 1
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The second compiler option is Option Strict. When this option is turned off, Visual Studio allows
your code to implicitly convert from one data type to another, even if the types are not always com-
patible. For example, Visual Basic will allow the following code to try to copy the string s into the
integer i. If the value in the string happens to be a number, as in the first case, this works. If

the string is not a number, as in the second case, this fails at runtime.

Dim i As Integer
Dim s As String

S = HlOH
i = s ' This works.
s = "Hello"

i =g ' This Fails.

If you set Option Strict to On, the IDE warns you at compile time that the two data types are
incompatible, so you can easily resolve the problem while you are writing the code. You can still use
conversion functions such as Clnt, Int, and Integer.Parse to convert a string into an Integer, but you
must take explicit action to do so. This makes you think about the code and reduces the chances
that the conversion is just an accident. This also helps you use the correct data types and avoid
unnecessary conversions that may make your program slower.

The third compiler directive, Option Compare, can take the values Binary or Text. If you set
Option Compare to Binary, Visual Basic compares strings using their binary representations. If you
set Option Compare to Text, Visual Basic compares strings using a case-insensitive method that
depends on your computer’s localization settings. Option Compare Binary is faster, but may not
always produce the result you want.

The final compiler directive, Option Infer, determines whether you can omit the data type when
declaring a variable and let Visual Basic deduce its data type from the context. For example, the first
statement in the following code declares the variable x, explicitly declaring it as a Single. The second
statement declares variable y without specifying a data type. Because y’s initialization value looks
like a Double, Visual Basic infers that the variable should be a Double.

Dim x As Single
Dim y = 3.14159265

The problem with inferred data types is that it is not obvious from the code what data type Visual
Basic should use. In the preceding code, you need to know Visual Basic’s inference rules to know
whether variable v is a Single, Double, or Decimal.

You can use an Option statement to set the values for each of these options at the top of a code
module. For example, the following code turns Option Explicit On and Option Infer Off for a
module:

Option Explicit On
Option Infer Off

Instead of using Option statements in a file, you can use the property page shown in Figure 2-8 to
set these options for all of the files in the application.
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OPTION RECOMMENDATIONS

To avoid confusion and long debugging sessions, I recommend that you use the
Compile property page to set Option Explicit On, Option Strict On, and Option
Infer Off to make Visual Basic as restrictive as possible. Then if you must loosen
these restrictions in a particular file, you can add an Option statement at the top of
the file. For example, you may need to set Option Infer On for a module that uses
LINQ. See Chapter 21, “LINQ,” for more information about LINQ.

A final item on this tab that deserves special mention is the “Generate XML documentation file”
checkbox near the bottom. If you check this box, then when you build the application Visual Studio
creates an XML document containing any XML comments you have included in the code. For more
information about XML comments, see the section “XML Comments” in Chapter 14, “Program
and Module Structure.”

Build

The Build menu contains commands that let you compile projects within a solution. The following
list describes the most useful commands contained in the Build menu:

>

Build WindowsApplicationl — This command compiles the currently selected project, in
this case the project WindowsApplicationl1. Visual Studio examines the project’s files to
see if any have changed since the last time it compiled the project. If any of the files have
changed, Visual Studio saves and recompiles them.

Rebuild WindowsApplicationl — This command recompiles the currently selected project
from scratch. It recompiles every file even if it has not been modified since the last time it
was compiled.

Clean WindowsApplicationl — This command removes temporary and intermediate files
that were created while building the application, leaving only the source files and the final
result .exe and .dlI files.

Publish WindowsApplicationl — This command displays the Publish Wizard shown in
Figure 2-9. It can walk you through the process of making your application available for
distribution in a local file, file share, FTP site, or web site.
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FIGURE 2-9: The Publish Wizard helps you deploy
an application.

If your solution contains more than one application, then the Build menu also contains the solution-
related commands Build Solution, Rebuild Solution, and Clean Solution. These are similar to their
application counterparts except they apply to every application in the solution.

Debug

The Debug menu contains commands that help you debug a program. These commands help you
run the program in the debugger, move through the code, set and clear breakpoints, and generally
follow the code’s execution to see what it’s doing and hopefully what it’s doing wrong.

For more information about the Debug menu and debugging Visual Basic code, see Chapter 7,
“Debugging.”

Data

The Data menu contains commands that deal with data and data sources. Some of the commands in
this menu are only visible and enabled if you are designing a form and that form contains the proper
data objects.

The following list describes the most useful Data menu commands:

> Show Data Sources — This command displays the Data Sources window, where you can
work with the program’s data sources. For example, you can drag and drop tables and fields
from this window onto a form to create controls bound to the data source.

> Preview Data — This command displays a dialog box that lets you load data into a DataSet
and view it at design time.
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>  Add New Data Source — This command displays the Data Source Configuration Wizard,
which walks you through the process of adding a data source to the project.

> Add Query — This command is available when you are designing a form and have selected
a data-bound control such as a DataGridView or bound TextBox. This command opens a
dialog where you can specify a query to add to the form. This places a ToolStrip on the
form containing ToolStripButtons that populate the bound control by executing the query.

Format

The Format menu contains commands that arrange controls on a form. The commands are grouped
into submenus containing related commands. The following list describes the Format menu’s submenus:

> Align — This submenu contains commands that align the controls you have selected in vari-
ous ways. It contains the commands Lefts, Centers, Rights, Tops, Middles, Bottoms, and to
Grid. For example, the Lefts command aligns the controls so their left edges line up nicely.
The to Grid command snaps the controls to the nearest grid position.

>  Make Same Size — This submenu contains commands that makes the dimensions of the
controls you have selected the same. It contains the commands Width, Height, and Both.
The Size to Grid command adjusts the selected controls’ widths so that they are a multiple
of the alignment grid size. (This command is disabled unless the Windows Forms Designer’s
LayoutMode is set to SnapToGrid. To set this, open the Tools menu, select the Options
command, go to the Windows Forms Designer tab, open the General sub-tab, and set the
LayoutMode property.)

> Horizontal Spacing — This submenu contains commands that change the horizontal
spacing between the controls you have selected. It contains the commands Make Equal,
Increase, Decrease, and Remove.

> Vertical Spacing — This submenu contains the same commands as the Horizontal Spacing
submenu except it adjusts the controls’ vertical spacing.

> Center in Form — This submenu contains the commands Horizontally and Vertically that
center the selected controls on the form either horizontally or vertically.

> Order — This submenu contains the commands Bring to Front and Send to Back, which
move the selected controls to the top or bottom of the stacking order.

> Lock Controls — This command locks all of the controls on the form so that you cannot
move or resize them by clicking and dragging, although you can still move and resize the
controls by changing their Location and Size properties in the Properties window. Invoking
this command again unlocks the controls.

Tools

The Tools menu contains miscellaneous tools that do not fit particularly well in the other menus.
It also contains a few duplicates of commands in other menus and commands that modify the IDE
itself.
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The following list describes the Tools menu’s most useful commands. Note that some of these com-
mands only appear when a particular type of editor is open.

>

Macros

Attach to Process — This command displays a dialog box to let you attach the debugger to
a running process.

Connect to Database — This command displays the Connection Properties dialog box,
where you can define a database connection. The connection is added to the Server Explorer
window. You can later use the connection to define data adapters and other objects that use
a database connection.

Connect to Server — This command displays a dialog box that lets you connect to a data-
base server.

Code Snippets Manager — This command displays the Code Snippets Manager, which you
can use to add and remove code snippets.

Choose Toolbox Items — This command displays a dialog box that lets you select the tools
displayed in the Toolbox. For instance, some controls are not included in the Toolbox by
default. You can use this command to add them if you will use them frequently.

Add-in Manager — This command displays the Add-in Manager, which lists the add-in
projects registered on the computer. You can use the Add-in Manager to enable or disable
these add-ins.

Macros — The Macros submenu contains commands that help you create, edit, and execute
macros. See the section “Macros” later in this chapter for details.

Extension Manager — This command displays an Extension Manager dialog that lets you
find Visual Studio extensions online and install them.

External Tools — This command displays a dialog box that lets you add and remove
commands from the Tools menu. For example, you could add a command to launch
WordPad, MS Paint, WinZip, and other handy utilities from the Tools menu.

Import/Export Settings — This command displays a dialog box that you can use to save,
restore, or reset your Visual Studio IDE settings. Use this dialog box to configure your
development environment for general development, project management, team test, Visual
Basic, C#, C++, or Web development.

Customize — This command allows you to customize the Visual Studio IDE. See Chapter 3,
“Customization,” for details.

Options — This command allows you to specify options for the Visual Studio IDE. See the
“Options” section later in this chapter for details.

The Macros submenu provides commands that help you create, edit, and execute macros that auto-
mate repetitive Visual Studio programming chores. If you must perform a series of actions many
times, you can record a macro that performs them. Then you can call the macro repeatedly to per-
form the actions rather than executing them manually.
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Some examples of macros that I’ve used in the past include code that:

> Arranges controls in unusual ways, such as spacing picture boxes around the edge
of a circle.

> Generates a long series of statements that does the same thing to a bunch of text values
(for example, makes Select Case statements for a series of text values).

> Sets up a new dialog box by creating the OK and Cancel buttons, positioning them, setting
their DialogResult properties, and setting the form’s AcceptButton and CancelButton
properties.

> Building a name and address form with labels and text boxes that have appropriate Anchor
properties.

Author John Mueller (www.mwt .net/~jmueller) uses similar macros to set up dialog boxes, create
standard menus, and build standard event handlers. You have other ways to do these things, such as
saving a pre-built dialog box for use as a template, or by using code snippets described later in this
chapter, but macros are quick and easy.

After you have recorded a macro, you can edit the macro’s code and make changes. For example, if
you want to run the code a certain number of times, you can include it in a For loop. Often, a quick
inspection of the code lets you figure out how to modify the macro to perform actions similar to
(but not exactly the same as) the actions you originally recorded.

Most of the commands in the Macros submenu are self-explanatory. Use the Record
TemporaryMacro command to record a macro for quick temporary use. When you select this
command, a small window pops up that contains buttons you can click to suspend, finish, or cancel
recording. Visual Studio saves the commands you execute in a macro named TemporaryMacro.

Select Run TemporaryMacro to run this macro. If you record a new TemporaryMacro, it
overwrites the existing one without warning you. Select the Save TemporaryMacro command to
rename the macro so you can record a new TemporaryMacro

without destroying the

previous one.

Select the Macro Explorer command to display the window
shown in Figure 2-10. If you right-click a macro, the resulting
pop-up menu lets you run, edit, rename, or delete the macro.
Notice the Macro Explorer’s predefined Samples section, which
contains example macros that you can use or modify for your
own use.

Sometimes when you perform a series of programming tasks many

times, you have better ways to approach the problem than writing a

macro. For example, you may be able to make your program repeat

the steps inside a loop. Or you may be able to extract the com-

mon code into a subroutine and then call it repeatedly rather than

repeating the code many times. In these cases, your application FIGURE 2-10: The Macro

doesn’t need to contain a long sequence of repetitive code that may ~ Explorer lets you edit, run, and
be hard to debug and maintain. delete macros.
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Macros are generally most useful when you must write similar pieces of code that cannot be eas-

ily extracted into a routine and shared by different parts of the application. For example, suppose
that you need to write event handlers for several dozen TextBox controls. You could record a macro
while you write one of them. Then you could edit the macro to make it generate the others in a loop
using different control names for each event handler. You could place the bulk of the event-han-
dling code in a separate subroutine that each event handler would call. That would avoid the need
for extensive duplicated code. (In fact, you could even use the AddHandler statement or a Handles
clause to make all the controls use the same event handler.)

Macros are also useful for manipulating the IDE and performing IDE-related tasks. For example,
you can write macros to show and hide your favorite toolbars, or to change whether the current file
is opened read-only.

Options

The Tools menu’s Options command displays the dialog box shown in Figure 2-11. This dialog box
contains a huge number of pages of options that configure the Visual Studio IDE.

FIGURE 2-11: The Options dialog box lets you specify IDE options.

The following list describes the Options dialog box’s most important categories:

>  Environment — Contains general IDE settings such as whether the IDE uses tabs or
multiple windows to display documents, the number of items shown in the most recently
used file lists, and how often the IDE saves AutoRecover information. The Fonts and
Colors subsection lets you determine the colors used by the editors for different types
of text. For example, comments are shown in green by default, but you can change
this color.

> Projects and Solutions — Contains the default settings for Option Explicit, Option Strict,
and Option Compare.
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Test

Source Control — Contains entries that deal with the source code control system (for exam-
ple, Visual SourceSafe). These systems provide file locking and differencing tools that let
multiple developers work on the same project without interfering with each other.

Text Editor — Contains entries that specify the text editor’s features. For example, you

can use these pages to determine whether delimiters are highlighted, whether long lines are
automatically wrapped, whether line numbers are displayed, and whether the editor pro-
vides smart indentation. The Basic &> VB Specific subsection lets you specify options such as
whether the editor uses outlining, displays procedure separators, and suggests corrections
for errors.

Debugging — Contains debugging settings such as whether the debugger displays messages
as modules are loaded and unloaded, whether it should make you confirm when deleting all
breakpoints, and whether it should allow Edit-and-Continue.

Database Tools — Contains database parameters such as default lengths for fields of vari-
ous types.

HTML Designer — Contains options for configuring HTML Designer. These options
determine such settings as whether the designer starts in source or design view, and whether
it displays Smart Tags for controls in design view.

Office Tools — Contains settings that specify how the keyboard should work when you use
Excel or Word files within Visual Studio.

Test Tools — Contains settings that determine how testing tools behave.

Windows Forms Designer — Contains settings that control the Windows Forms Designer.
For example, this section lets you determine whether the designer uses a snap-to grid or
snap lines and how far apart grid points are.

The Test menu contains commands that control the Visual Studio testing tools. These tools let you
perform such actions as coverage testing (to see if every line of code is executed), regression testing
(to see if changes to the code broke anything), and load testing (to see how the application performs
with a lot of simulated users running at the same time).

The following list briefly describes the Test menu’s commands:

>

New Test — Displays a dialog box that lets you create various kinds of tests for the
application.

Load Metadata File — Lets you load a test metadata file. These XML files describe test
lists, each of which can contain tests. This command lets you load test lists into different
projects.

Create New Test List — Lets you make a new test list. Test lists let you group related tests
so that you can execute them together. For example, you might have test lists for user inter-
face testing, print tests, database tests, and so forth.

Run — Starts executing the currently active test project without the debugger.
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>

>

Debug — Starts executing the currently active test project with the debugger.

Windows — Displays test-related windows including Test View, Test List Editor, Test
Results, and Test Runs.

The Window menu contains commands that control Visual Studio’s windows. Which commands are
enabled depends on the type of window that has the focus. For example, if focus is on a code editor,
the Split command is enabled and the Float, Dock, and Dock as Tabbed Document commands are
disabled, but when the Solution Explorer window has the focus, the opposite is true.

The following list briefly describes the most useful of these commands:

>

Split — Splits a code window into two panes that can display different parts of the code at
the same time. This command changes to Remove Split when you use it.

Float, Dock, Dock as Tabbed Document — Secondary windows such as the Toolbox,
Solution Explorer, and Properties windows can be displayed as dockable, floating, or tabbed
documents. A dockable window can be attached to the edges of the IDE or docked with
other secondary windows. A floating window stays in its own independent window even

if you drag it to a position where it would normally dock. A tabbed document window is
displayed in the main editing area in the center of the IDE with the forms, classes, and other
project files.

Auto Hide — Puts a secondary window in Auto Hide mode. The window disappears, and
its title is displayed at the IDE’s nearest edge. When you click the title or hover over it, the
window reappears so that you can use it. If you click another window, this window hides
itself again automatically.

Hide — Removes the window.
Auto Hide All — Makes all secondary windows enter Auto Hide mode.

New Horizontal Tab Group — Splits the main document window horizontally so that you
can view two different documents at the same time.

New Vertical Tab Group — Splits the main document window vertically so that you can
view two different documents at the same time.

Close All Documents — Closes all documents.
Reset Window Layout — Resets the window layout to a default configuration.

Form1.vb — The bottom part of the Window menu lists open documents such as form,
code, and bitmap editors. The menu displays a checkmark next to the currently active
document. You can select one of these entries to quickly view the corresponding document.

Windows — If you have too many open documents to display in the Window menu, select
this command to see a list of the windows in a dialog. This dialog box lets you switch to
another document, close one or more documents, or save documents. By pressing Ctrl+Click
or Shift+Click you can select more than one document and quickly close them.



Secondary Windows | 37

Help

The Help menu displays the usual assortment of help commands. You should be familiar with most
of these from previous experience. The following list summarizes some of the more interesting non-
standard commands:

> Visual Studio Documentation — Opens Visual Studio documentation in a web browser.

>  MSDN Forums — Opens an MSDN community forums web page where you can post and
search for answers to questions.

> Report a Bug — Opens the Microsoft Developer Division Feedback Center where you can
report bugs, make suggestions, and look for hot fixes for known problems.

>  Samples — Opens a Microsoft web page containing links to Visual Studio documentation
and samples.

>  Customer Feedback Options — Displays a dialog that lets you indicate whether you want to
participate in Microsoft’s anonymous Customer Experience Improvement Program. If you
join, Microsoft collects anonymous information about your system configuration and how
you use its software.

Check for Updates — Check online for Visual Studio updates.

Technical Support — Opens a help page describing various support options. The page
includes phone numbers and links to more information.

TOOLBARS

The Visual Studio toolbars are easy to rearrange. Simply grab the four gray dots on a toolbar’s left
or upper edge and drag the toolbar to its new position. If you drag a toolbar to one of the IDE’s
edges, it will dock there either horizontally (on the IDE’s top or bottom edge) or vertically (on the
IDE’s left or right edge). If you drop a toolbar away from the IDE’s edges, it becomes a floating
window not docked to the IDE.

You can use the IDE’s menu commands to determine which toolbars are visible, to determine
what they contain, and to make custom toolbars of your own. See Chapter 3, “Customization,” for
more details.

Many menu commands are also available in standard toolbars. For example, the Debug toolbar con-
tains many of the same commands that are in the Debug menu. If you use a set of menu commands
frequently, you may want to display the corresponding toolbar to make using the commands easier.
Alternatively, you can make your own custom toolbar and fill it with your favorite commands.

SECONDARY WINDOWS

You can rearrange secondary windows such as the Toolbox and Solution Explorer almost as easily
as you can rearrange toolbars. Click and drag the window’s title bar to move it. As the window
moves, the IDE displays little blue icons to help you dock the window, as shown in Figure 2-12. This
figure probably looks somewhat confusing, but it’s fairly easy to use.
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FIGURE 2-12: Use the IDE’s docking icons to help you dock windows.

When you drag the window over another window, the IDE displays docking icons for the other
window. In Figure 2-12, these are the five center most icons. The four icons on the sides dock the
window to the corresponding edge of the other window.

The center icon places the dropped window in a tab within the other window.

When you drag the mouse over one of the docking icons, the IDE displays a pale blue rectangle to
give you an idea of where the window will land if you drop it. In Figure 2-12, the mouse is over
the main document window’s right docking icon, so the blue rectangle shows the dropped window
taking up the right half of the main document window.

If you drop a window somewhere other than on a docking icon, the window becomes free-floating.

When you drop a window on the main document area, it becomes a tabbed document within that
area, and you cannot later pull it out. To free the window, select it and use the Window menu’s
Dock or Float command.

Sometimes the IDE is so cluttered with windows that it’s hard to figure out exactly where the
window will be dropped. It’s usually fairly easy to just move the mouse around a bit and watch the
pale blue rectangle to see what’s happening.

The windows in the Microsoft Document Explorer used by the MSDN Library and other external
help files provide the same arranging and docking tools for managing its subwindows such as Index,
Contents, Help Favorites, Index Results, and Search Results.
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This section describes some of the general features of the IDE’s secondary windows. The follow-
ing sections describe two of the most important of those secondary windows: the Toolbox and the
Properties window.

Toolbox

The Toolbox window displays tools that you can use with the currently active document. The tools
are available when you are editing a Windows Form, WPF Form, UserControl, web page, or other
item that can contain objects such as controls and components.

The tools are grouped into sections called zabs,
although they don’t look much like the tabs on most
documents. The Toolbox in Figure 2-13 displays
tools for the Windows Forms Designer. The All
Windows Forms section is showing its tools as icons
whereas the Data section is listing its tools by name.
Other tabs are hidden. In this figure, the Toolbox
was enlarged greatly to show most of its contents.
Most developers keep this window much smaller and
docked to the left edge of the IDE.

You can customize the Toolbox by right-

clicking a tab and selecting one of the commands

in the context menu. The following list briefly

describes the most useful of these commands:

FIGURE 2-13: The Toolbox window can display

> List View — Toggles the current tab to .
tools by name oricon.

display tools either as a list of names (as in
the Data section in Figure 2-13) or a series of icons (as in the All Windows Forms
section in Figure 2-13).

> Show All — Shows or hides less commonly used tool tabs such as XML Schema, Dialog
Editor, DataSet, Login, WPF Interoperability, Windows Workflow, Device Controls, and
many others.

>  Choose Items — Displays the dialog box shown in Figure 2-14. Use the .NET Framework
Components tab to select .NET tools, and use the COM Components tab to select COM
tools. Click the Browse button to locate tools that are not in either list.

> Sort Items Alphabetically — Sorts the items within a Toolbox tab alphabetically.
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FIGURE 2-14: Use the Choose Toolbox Items dialog box to
select the tools in the Toolbox.

> Reset Toolbox — Restores the Toolbox to a default configuration. This removes any items
you may have added by using the Choose Items command.

> Add Tab — Creates a new tab where you can place your favorite tools. You can drag tools
from one tab to another. Hold down the Ctrl key while dragging to add a copy of the tool to
the new tab without removing it from the old tab.

> Delete Tab — Deletes a tab.
Rename Tab — Lets you rename a tab.

> Move Up, Move Down — Moves the clicked tab up or down in the Toolbox. You can also
click and drag the tabs to new positions.

If you right-click a tool in the Toolbox, the context menu
*contains most of these commands plus Cut, Copy, Paste, Delete,
and Rename Item.

Properties Window

When you are designing a form, the Properties window allows you
to view and modify the properties of the form and of the controls
that it contains. Figure 2-15 shows the Properties window
displaying properties for a Button control named btnCalculate.
You can see in the figure that the control’s Text property

is “Calculate” so that’s what the button displays to the user.

Figure 2-15 shows some important features of the Properties win-  FIGURE 2-15: The Properties
dow that deserve special mention. At the top of the window is a window lets you view and modify
drop-down list that holds the names of all of the controls on the control properties.
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form. To select a control, you can either click it on the Windows Forms Designer or select it from
this list.

The buttons in the row below the dropdown determine what items are displayed in the window

and how they are arranged. If you click the leftmost button, the window lists properties grouped by

category. For example, the Appearance category contains properties that affect the control’s appear-
ance such as BackColor, Font, and Image. If you click the second icon that holds the letters A and Z,
the window lists the control’s properties alphabetically.

Arranging properties alphabetically makes finding properties easier for many
developers.

The third icon makes the window display the control’s properties and the fourth icon (which
displays a lightning bolt) makes the window display the control’s events instead. (Yes, it’s a little
odd that the Properties window displays either properties or events, but there is no Events window.)

For more information on using the Properties window to edit properties and create event handlers in
the Windows Forms Designer, see Chapter 4, “Windows Forms Designer.”

SUMMARY

The Visual Studio integrated development environment provides a huge number of tools for
manipulating projects. Menus and toolbars contain hundreds if not thousands of commands for
creating, loading, saving, and editing different kinds of projects and files.

This chapter describes the most useful and important commands available in the IDE’s menus and
toolbars. The kinds of menus, toolbars, and commands that are available depend on the type of
window that currently has focus, in addition to the project’s current state. For example, the Format
menu contains commands that arrange controls on a form so it is only available when you are using
a Windows Forms Designer.

Chapter 3, “Customization,” explains in greater detail how you can rearrange Visual Studio’s
toolbars and menus to meet your needs. It explains how you can make your own toolbars and
menus and fill them with the commands that you find most useful during your day-to-day
development.






Customization

The Visual Studio IDE is packed with thousands of tools that are available through toolbar
and menu commands. So many tools are available that the IDE would be practically useless if
every tool were displayed at the same time. In the interests of usability, the IDE displays only
the tools that the Microsoft Visual Studio developers thought would be most useful when you
were performing a particular task.

Unfortunately, the Microsoft developers didn’t know exactly what you would be doing while
developing applications, so they made their best guesses about which tools you would need.
Under some circumstances, you may find that a completely different set of tools would be
more useful. In those cases, you should customize the IDE to make using those tools easier
and faster.

This chapter explains how you can customize the IDE. It explains how to make new toolbars
and menus, add commands to them, and determine the commands’ appearances. It also tells
how you can define keyboard shortcuts to make the commands you use most often really easy
to access.

ADDING COMMANDS

The Tools menu’s Customize command displays the dialog box shown in Figure 3-1. On the
Toolbars tab, select the check boxes next to the toolbars that you want to be visible. Click
New to create a new toolbar where you can add your favorite tools. You can leave the toolbar
floating or drag it to the edge of the IDE and dock it. If you drag it to the top, it joins the
other toolbars.
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FIGURE 3-1: The Customize dialog box’s Toolbars tab lets
you determine which toolbars are visible.

Click the Commands tab and select a menu. Then click the Add Command button to see the dialog
shown in Figure 3-2. Select a command in the dialog and click OK to add it to the menu you
originally selected.

FIGURE 3-2: The Add Command dialog lets you add com-
mands to toolbars and menus.

To make a command that executes a macro you have created, select the Macros category in the list on
the left. Find the macro you want to use in the list on the right, and drag it onto a toolbar or menu.

To create a new menu, click the Customize dialog’s Add New Menu button.
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FIGURE 3-3: The Options dialog’s Keyboard section lets you view and
modify keyboard shortcuts.

MAKING KEYBOARD SHORTCUTS

Keyboard shortcuts let you quickly invoke a command by pressing a key combination. For example,
in most applications including Visual Studio, Ctrl+S invokes the save command.

The Keyboard button at the bottom of the Customize dialog displays the dialog box shown in
Figure 3-3. You can use this dialog to view and edit keyboard shortcuts.

Enter words in the “Show commands containing” text box to filter the commands. When you click
a command, the dialog box displays any keyboard shortcuts associated with it.

To make a new shortcut, click the “Press shortcut keys” text box and press the keys that you want
to use as a shortcut. The “Shortcuts for selected command” drop-down list displays any commands
that already use the shortcut you entered. To make the assignment, click the Assign button.

CONFUSING SHORTCUTS

To avoid confusion, don’t use standard shortcuts for non-standard commands.
For example, Ctrl+S normally makes the IDE save the currently selected items

(for example, the file you are editing). Changing the meaning of Ctrl+S so it runs a
macro that builds a sales form could be very confusing later.

When you type a new shortcut sequence in the “Press shortcut keys” box, look in
the “Shortcut currently used by” list to see if that combination of keys is already
assigned to another command. If the combination is in use, try something
different.
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SUMMARY

The Visual Studio IDE comes with a huge assortment of tools. Initially the IDE’s menus and tool-
bars are arranged to make it easy to access the tools that developers use most often, but if you
need to use some other tool frequently, you are not limited to the IDE’s initial layout. This chapter
explains how you can create, hide, and rearrange menus and toolbars to make it easy to use the
tools that you find most useful.

In addition to its many menus and toolbars, the IDE contains dozens of windows that contain tools
or that allow you to view and modify different aspects of an application. Of all the windows dis-
played by the IDE, one of the first that Visual Basic developers use when building a new application
is the Windows Forms Designer. This window allows you to add controls to a form, arrange them to
create a user interface, and set their properties to determine their appearances and behaviors.

Chapter 4, “Windows Forms Designer,” explains how to use the Windows Forms Designer to build
the forms that make up most Windows applications.



Windows Forms Designer

The Windows Forms Designer allows you to design forms for typical Windows applications.
It lets you add, size, and move controls on a form. Together with the Properties window, it
also lets you change a control’s properties to determine its appearance and behavior.

This chapter provides an introduction to the Windows Forms Designer. It explains how to
add controls to a form, move and size controls, set control properties, and add code

to respond to control events. It also describes tips and tricks that make working with
controls easier.

SETTING DESIGNER OPTIONS

When you first install Visual Studio, the Windows Forms Designer is configured to be quite
usable. You can immediately open a form and use the Toolbox to place controls on it. You
can use the mouse to move and resize controls. You can use the Format menu to arrange and
size controls. Overall the Windows Forms Designer provides a first-class intuitive WYSIWYG
(“what you see is what you get”) experience.

Behind the scenes, however, there are a few configuration options that control the Designer’s
behavior and that you should know about to get the most out of the Designer.

To view the Designer’s options, open the Tools menu, select Options, open the Windows
Forms Designer branch, and select the General page to display the dialog shown in
Figure 4-1.
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FIGURE 4-1: This dialog lets you control the Windows Forms
Designer’s behavior.

The following list describes the most important of these settings.

>

Optimized Code Generation — Determines whether Visual Studio generates optimized
code. This setting is here instead of some more code-oriented part of the Options dialog
because some controls may be incompatible with code optimization.

Grid Size — Determines the horizontal and vertical dimensions of the sizing grid for use
when LayoutMode is SnapToGrid.

LayoutMode — Determines whether Visual Studio uses snap-to-grid or snap lines. If this
is SnapToGrid, objects automatically snap to the nearest grid point when you drag or resize
them. When this is SnapLines, resized controls automatically snap to lines that align with
the edges or centers of other controls, or with the form’s margins. Both of these options
make it easy to build controls that are consistently sized and that align along their edges.
The two options have a very different feel, however, so you might want to experiment with
both to see which one you like best.

Automatically Open Smart Tags — Determines whether Visual Studio displays smart tags
by default.

EnableRefactoringOnRename — Determines whether Visual Studio performs refactoring
when you rename a control. (Refactoring is the process of restructuring the code, hopefully
to make it better.) If this setting is True and you change a control’s name, Visual Studio
updates any code that uses that control so it uses the new name. If this setting is False and
you rename a control, any code that refers to the control still uses its old name, so the code
will no longer work.

AutoToolboxPopulate — Determines whether Visual Studio adds components built by the
solution to the Toolbox window.
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USEFUL OPTIONS

Which LayoutMode you should use is a matter of preference. I know many devel-
opers who use each style. The EnableRefactoringOnRename option can save you a
lot of trouble when you rename controls so it’s almost always worth leaving True.

ADDING CONTROLS

The Windows Forms Designer allows you to add controls to a form in several ways.

First, if you double-click a control on the Toolbox, Visual Studio places an instance of the control
on the form in a default location and at a default size. You can then use the mouse to move and
resize the control.

( yi When you use this method, the new control is placed inside the currently

selected container on the form. If the currently selected control is a
GroupBox, the new control is placed inside the GroupBox. If the currently
selected control is a TextBox that is inside a Panel, the new control is placed
inside the Panel.

Second, if you click a control in the Toolbox, the mouse cursor changes while the mouse is over
the form. The new cursor looks like a plus sign with a small image of the control’s Toolbox icon
next to it. If you click the form, Visual Studio adds a control at that location with a default size.
Instead of just clicking, you can click and drag to specify the new control’s location and size. After
you place the new control, the mouse returns to a pointer cursor so you can click existing controls
to select them.

(yi If you hold down the Control key when you click or drag on the form, the

Designer adds the new control to the form and keeps the control’s Toolbox
tool selected so you can add another instance of the control. For example,
suppose you need to create a series of TextBoxes to hold a user’s name,
street, city, state, and ZIP code. Select the TextBox tool in the Toolbox. Then
you can quickly use Ctrl+Click five times to create the TextBoxes. Press the
Escape key to stop adding TextBoxes and then drag them into their correct
positions.
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SELECTING CONTROLS

When you first create a control, the Designer selects it. The Designer
indicates that the control is selected by surrounding it with white boxes.
In Figure 4-2, the Button2 control is selected.

To select a control on the Designer later, simply click it.

FIGURE 4-2: The Designer
surrounds a selected control
with white boxes.

You can click and drag to select a group of controls. As you drag the
mouse, the Designer displays a rectangle so you can tell which controls
will be selected. When you release the mouse button, all of the controls
that overlap the rectangle at least partly are selected.

When you select a group of controls, the Designer surrounds most of
them with black boxes. It surrounds a special “master” control with
white boxes. In Figure 4-3, four buttons are selected. Button1 is the
“master” control so it is surrounded by white boxes.

The Designer uses the “master” control to adjust the others if

you use the Format menu’s commands. For example, if you use the
Format = Make Same Size & Height command, the Designer gives the
“black box™ controls the same height as the “master” control. Similarly
the Format = Align © Tops command moves the “black box™ controls
so their tops are the same as the top of the “master” control.

FIGURE 4-3: The selection’s
“master” control is surrounded
by white boxes.

To change the “master” control, simply click the control that you want to use as the “master.”

After you have selected some controls, you can Shift+Click or Ctrl+Click to add and remove single
controls from the selection. You can Shift+Click-and-drag or Ctrl+Click-and-drag to add and
remove groups of controls from the selection.

TRICKY CLICKS

Under some circumstances, the Designer will not remove its selection even if
you click the form off of the selected controls. To deselect all of the controls, either
click a control that is not selected or press the Escape key.

COPYING CONTROLS

A particularly useful technique for building a series of similar controls is to build one and then use
copy and paste to make others.

For example, to build the name, street, city, state, and ZIP code TextBoxes described in the previous
section, you could start by adding the Name TextBox to the form. Next, set all of the properties
for the control that will be shared by the other controls. For example, you may want to adjust the
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TextBox’s width, set its MaxLength property to 20, and set its Anchor property to “Top, Left,
Right” so it resizes horizontally when its container resizes. Now select the control on the Designer
and press Ctrl+C to copy it. Then press Ctrl+V repeatedly to make copies for the other controls.
Drag the controls into position and you have quickly built all of the controls with their shared
properties already set.

CONTAINER CONFUSION

When you paste a copied control, the new control is placed inside whatever con-
tainer is currently selected on the form. This can be confusing if you quickly copy
and paste a container. For example, suppose you want to make three GroupBoxes.
You build one and size it the way you want it. Then you press Ctrl+C, Ctrl+V,
Ctrl+V. The first GroupBox is copied and the first copy is pasted inside the original
GroupBox. Then the second copy is also placed inside the first copy. The result is
somewhat confusing and you’ll probably need to drag the copies out onto the form
before you can place them where you want.

You can also use copy and paste to copy a group of controls. For example, suppose you want to
make name, street, city, state, and ZIP code TextBoxes but you also want Label controls to the left
of the TextBoxes. First create the name Label and TextBox, set their properties, and position them
so they are lined up vertically and the Label is to the left of the TextBox as desired. Click and drag
to select both controls and then press Ctrl+C to copy them both. Now when you press Ctrl+V, the
Designer makes a copy of the Label and the TextBox. The copies are lined up vertically and the
Label is to the left of the TextBox as in the originals. The new controls are even both selected so you
can use the mouse to grab them both and drag them into position.

MOVING AND SIZING CONTROLS

Moving a control in the Windows Forms Designer is easy. Simply click and drag the control to its
new position.

To move a group of controls, select the controls that you want. Then click one of the controls and
drag to move the whole group.

Note that you can drag controls in and out of container controls such as the FlowLayoutPanel,
GroupBox, Panel, and PictureBox. When you drag a control into a new container, the mouse
cursor acquires a little fuzzy rectangle on the lower right. If you are dragging a control and you
see this appear, you know that dropping the control at the current position will move it into a
new container. The new container indicator appears if you are dragging a control from the form
into a container, from a container onto the form, or from one container to another.
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Resizing a control is almost as easy as moving one. Click a control to select it. Then click and drag
one of the white boxes surrounding the control to change its size.

To resize a group of controls, select the group. Then click and drag one of the boxes surrounding
one of the controls. When you drag the mouse, the control beside the box you picked is resized as if
it were the only control selected. The other selected controls resize in the same manner. For example,
if you widen the clicked control by eight pixels, all of the other controls widen by eight pixels, too.

ARRANGING CONTROLS

The Format menu contains several submenus that hold tools that make arranging controls easier.
For example, the Format menu’s Align submenu contains commands that let you align controls
vertically and horizontally along their edges or centers.

For a description of this menu’s commands, see the section “Format” in Chapter 2, “Menus,
Toolbars, and Windows.” (Or just experiment with these commands — they aren’t too complicated.)

For more information about how the selection’s “white box master” control determines how other
controls are adjusted, see the section “Selecting Controls” earlier in this chapter.

SETTING PROPERTIES

When you select a control, the Properties window allows you to view and edit the control’s proper-
ties. For most properties, you can simply click the property and type a new value for the control.
Some properties are more complex than others and provide drop-down lists or special dialogs to
set the property’s value. Most of the editors provided for setting property values are fairly self-
explanatory, so they are not described in detail here.

In addition to using the Properties window to set a single control’s properties one at a time, you
can quickly set property values for groups of controls in a couple of ways. The following sections
describe some of the most useful of these techniques.

Setting Group Properties

If you select a group of controls, you can sometimes use the Properties window to give all of the
controls the same property value all at once. For example, suppose you select a group of TextBoxes.
Then you can use the Properties window to give them the same values for their Anchor, Text,
MultiLine, Font, and other properties simultaneously.

Sometimes, this even works when you select different kinds of controls at the same time. For exam-
ple, if you select some TextBoxes and some Labels, you can set all of the controls’ Text properties at
the same time. You cannot set the TextBoxes’ MultiLine properties because the Labels do not have a
MultiLine property.
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BLANKING TEXT

One handy use for this technique is to set the Text property to a blank string for a
group of TextBox controls. Unfortunately, if the selected TextBoxes have different
Text values, the Properties window displays a blank value for the Text property.
If you then try to make the property blank, the Properties window doesn’t think
you’ve changed the value, so it doesn’t blank the controls’ Text properties.

To work around this restriction, first set the Text property to any non-blank value
(“ »

x” will do) to give all of the controls the same value. Then delete the Text value
to blank all of the controls’ Text values.

Setting Different Properties for Several Controls

When you select a control on the Windows Forms Designer, the Properties window initially selects
a property for the control. The property selected depends on the kind of control you select and on
the property currently selected in the Properties window.

If the newly selected and previously selected controls both have the currently selected property,
the Properties window keeps that property selected. Otherwise the Properties window selects the
default property for the newly selected control.

For example, suppose you select a Label control on the Designer and then click the TabIndex prop-
erty in the Properties window. Now suppose you select a TextBox in the Designer. Because the
TextBox also has a TabIndex property, that property remains selected in the Properties window.

In contrast, suppose you select a Button and click the Text property. Now suppose you click on
a ListBox. The ListBox control doesn’t have a Text property so the Properties window selects its
default property (which is Items).

Because the Properties window tries to keep the same property selected, you can easily give a series
of controls different values for the same property. For example, suppose you copy and paste to
make a series of TextBoxes, and you want to give them good names. Select one TextBox, click its
Name property in the Properties window, and type the new name (for example, txtName). Now
click a different TextBox on the Windows Forms Designer. The Name property is still selected in
the Properties window. If you immediately type this control’s name (for example, txtStreet), the
Properties window assigns the control the new name. You can repeat this process of selecting a new
TextBox and typing its name very quickly.

WPF WANTING

Unfortunately, the WPF Designer is missing this feature (and many others). You
need to click the Name property each time you want to change a control’s name.
Hopefully this designer will catch up with the Windows Forms Designer some day.
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Using Smart Tags

Many controls display a smart tag when you select them on
the Designer. The smart tag looks like a little box contain-

ing a right-pointing triangle. When you click the smart tag,
a small dialog appears to let you perform common tasks for

the control quickly and easily.
FIGURE 4-4: The PictureBox control’s

Figure 4-4 shows a PictureBox with the smart tag expanded.  smart tag lets you choose an image,
Because the smart tag’s dialog is visible, the smart tag indica-  set the control’s SizeMode, or dock the
tor shows a left-pointing triangle. If you click this, the dialog  control in its container.

disappears.

The PictureBox control’s smart tag dialog lets you choose an image for the control, set the control’s
SizeMode, or dock the control in its container. These actions set the control’s Image, SizeMode, and
Dock properties.

Many controls, particularly the more complicated kinds, provide smart tags to let you perform
common actions without using the Properties window.

ADDING CODE TO CONTROLS

After you have added the appropriate controls to a form and set their properties, the next step is to
add code to the form that responds to control events and that manipulates the controls.

You use the code editor to write code that responds to control events. The code editor is described in
Chapter 6, “Visual Basic Code Editor,” but you can open the code editor from the Windows Forms
Designer.

An event handler is a code routine that catches an event raised by a control and takes some action.
Almost all program action is started from an event handler. Even actions started automatically by a
timer begin when an event handler catches a timer’s events.

If you double-click a control on the Windows Forms Designer, Visual Studio creates an empty event
handler to handle the control’s default event and it opens the event handler in the code editor. For
example, the following code shows the event handler the IDE built for a Button control named
Buttonl. The default event for a Button is Click so this code is a Click event handler. (Note that I
added the line continuation in the first line so it would fit in the book. Visual Studio makes that all
one long line.)

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) H